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Safety summary 1

The following general safety precautions must be observed during all phases of operation, service and 
repair of this equipment. Failure to comply with these precautions or with specific warnings elsewhere 
in this manual violates safety standards of design, manufacture and intended use of the equipment. 
Thrane & Thrane assumes no liability for the customer's failure to comply with these requirements.

Observe marked areas
Under extreme heat conditions do not touch areas of the terminal or 
antenna that are marked with this symbol, as it may result in injury.

Microwave radiation hazards
During transmission the antenna in this system radiates Microwave 
Power.This radiation may be hazardous to humans close to the antenna. 
When the system is powered, make sure that nobody gets closer than the 
recommended minimum safety distance. 

The minimum safety distance is 1 m to the side and above the antenna when 
the EXPLORER 727 is powered. The safety distance of 1 m does not apply 
directly below the antenna, as the radiation forms a hemisphere above the antenna.

Service
User access to the interior of the system units is prohibited. Only a technician authorized by Thrane & 
Thrane may perform service - failure to comply with this rule will void the warranty.

Do not service or adjust alone
Do not attempt internal service or adjustments unless another person, capable of rendering first aid 
resuscitation, is present.

Power supply
The voltage range is 10.5 - 32 V DC; 14 A - 5.5 A. Be aware of high start-up peak current: 20 A@24 V, 
5 ms.

Do not operate in an explosive atmosphere
Do not operate the equipment in the presence of flammable gases or fumes. Operation of any 
electrical equipment in such an environment constitutes a definite safety hazard.

Keep away from live circuits
Operating personnel must not remove equipment covers. Component replacement and internal 
adjustment must be made by qualified maintenance personnel. Do not replace components with the 
power cable connected. Under certain conditions, dangerous voltages may exist even with the power 
cable removed. To avoid injuries, always disconnect power and discharge circuits before touching 
them.

Install and use the antenna with care
Thrane & Thrane assumes no liability for any damage caused by the antenna falling off the vehicle or 
stressing the mounting base. It is the responsibility of the customer to ensure a safe and correct 
installation of the antenna. The instructions in the Installation manual are only guidelines.

Failure to comply with the rules above will void the warranty!
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About the manual 2

Intended readers

This manual is a user manual for the EXPLORER 727 system. The readers of the manual 
include anyone who is using or intends to use this system. No specific skills are required to 
operate the EXPLORER 727 system. However, it is important that you observe all safety 
requirements listed in the beginning of this manual, and operate the system according to 
the guidelines in this manual. 

Manual overview

Note that this manual does not cover installation nor does it cover how to use the IP 
handset that comes with the system. For information on installation refer to the installation 
manual and for information on the IP handset refer to the user manual for the IP handset. 
Part numbers for both manuals are listed in the next section.

This manual has the following chapters:

• Introduction contains a brief description of the system and an overview of the BGAN 
services.

• Getting started explains how to insert SIM card and start up the unit. It also contains a 
short guide to making the first call.

• Operating the system explains how to use the system.

• Using the web interface explains how to use the built-in web interface of the terminal, 
and describes the available menus and settings, including advanced setup of 
interfaces.

• Troubleshooting contains a short troubleshooting guide and explains how to update 
software. It also describes the functions of the light indicators and the Reset button, 
and explains the event messages that may show in the web interface. Further, it gives 
information on where to get help if needed.

This manual may not always reflect the latest software functionality of your EXPLORER 
system. To obtain the latest version of the manual, please enter the Thrane & Thrane web 
site www.thrane.com and download the latest version, or acquire it from your distributor.
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Related documents

The below list shows the documents related to this manual and to the EXPLORER 727 
system.

Typography

In this manual, typography is used as indicated below:

Bold  is used for the following purposes:

• To emphasize words. 
Example: “Do not touch the antenna”.

• To indicate what the user should select in the user interface. 
Example: “Select SETTINGS > LAN”. 

Italic  is used to emphasize the paragraph title in cross-references.
Example: “For further information, see Connecting Cables on page...”.

Title and description
Document 
number

EXPLORER 727 Including 19” Rack Version, Installation Manual

Explains how to install the EXPLORER terminal and the EXPLORER 727 
antenna.

TT98-126844

EXPLORER 727, Quick Guide

A short guide to the most important functions of the EXPLORER 727 
system.

TT98-126881

EXPLORER 727, Getting Started

Explains how to start up your EXPLORER 727 system and make the first 
call or data session.

TT98-126880

Thrane IP Handset, User Manual

Explains the features and functions of the Thrane IP Handset. The IP 
handset works as a standard IP handset, but also serves as a user 
interface for the EXPLORER 727 system.

TT98-126059
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Chapter 1
Introduction 1

Welcome

Congratulations on the purchase of your EXPLORER 727 system!

EXPLORER 727 is a land vehicular broadband system, providing simultaneous high-speed data 
and voice communication via satellite through the Broadband Global Area Network (BGAN).

Applications include:

• Internet browsing

• E-mail

• Phone and fax services

• Large file transfers

• Video conferencing and Streaming

• VPN (Virtual Private Network) access to corporate servers

In this chapter

This chapter introduces the EXPLORER 727 system and gives an overview of the physical units and 
their features and functions.

It also gives an overview of the BGAN system and services.
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Chapter 1: Introduction
Features and interfaces

The EXPLORER 727 system offers the following features and interfaces:

 Simultaneous voice and data communication over BGAN

 Full duplex, single or multi-user, up to: 432 kbps

 Support for streaming IP at: 32, 64, 128, 256 kbps

 ISDN service: 64 kbps

 Voice: Standard Voice (4.0 kbps) or 3.1 kHz Audio

 4 LAN (Local Area Network) ports with PoE (Power over Ethernet) for computers, e-hubs, IP 
handsets etc.

 2 Standard Phone/Fax ports for standard phones, fax machines or analog modems

 1 Euro ISDN port for ISDN phones, G4 fax or ISDN modem

 1 multi-purpose I/O connector with 5 configurable inputs/outputs

 1 SIM slot for your BGAN SIM card

 Built-in DHCP/NAT router 

 Built-in web interface allowing you to manage your phone book, messages and calls, and 
customize the terminal to your specific needs

 Input power: 10.5 - 32 V DC (14 A - 5.5 A)

 CE certified
98-126882-C Features and interfaces 2



Chapter 1: Introduction
Main units

Units overview

The EXPLORER 727 system TT-3722A includes the following main units:

• TT-3053B EXPLORER 727 antenna

• TT-3736A EXPLORER Terminal or TT-3736A-T19 EXPLORER 19" Rack Terminal

• TT-3670A Thrane IP Handset & Cradle, wired

EXPLORER®727 antenna

The EXPLORER 727 system uses the TT-3053B antenna, which is a mechanically steered 2-axis 
stabilized BGAN antenna, intended for roof mounting on a vehicle. The antenna contains all 
functions for satellite tracking, including a GPS system. A single coaxial cable carries all RF 
communication, supply voltage and modem communication between the antenna and the 
terminal.

For information on how to install the antenna, refer to the installation manual.

 

98-126882-C Main units 3



Chapter 1: Introduction
EXPLORER® terminal

Overview

The EXPLORER Terminal is the controlling unit in the EXPLORER 727 system. It contains all user 
interfaces and LED indicators and stores configuration data. The terminal is designed to be 
mounted inside a vehicle. 

The terminal is also available in a 19” Rack version. The 19” Rack terminal is the same as the basic 
version, except for the housing which fits in a 19” rack and has an additional power switch on the 
front panel.

For information on how to install the terminal, refer to the installation manual.

Tools for setup and daily use

The Thrane IP handset can be used for displaying status and for entering the PIN code for the 
terminal. The IP handset connects to the LAN interface of the terminal. For information on how to 
use the handset menus, see the user manual for the IP handset.

The built-in web interface is used for easy configuration and daily use. The web interface is 
accessed from a computer connected to the terminal, using an Internet browser. No installation of 
software is needed.
For further information on the web interface, see Chapter 4, Using the web interface.
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Chapter 1: Introduction
SIM card

The terminal has a SIM slot (Subscriber Identity Module) located in the connector panel behind a 
small cover plate.

The terminal requires a dedicated land vehicular SIM card, which you get from your Airtime 
Provider.

The system requires a SIM card to go online and to access the settings of the terminal. However, 
using the web interface you can view the Dashboard and upload software without inserting a SIM 
card. Upload of software without a SIM card requires an administrator user name and password.
98-126882-C Main units 5



Chapter 1: Introduction
IP handset and cradle

IP handset

The Thrane IP Handset communicates using Internet protocols. The 
handset is not strictly dedicated to the EXPLORER 727 system, but 
can also be used in a public network as a standard IP telephone. 

The IP handset is powered directly from the LAN interface using 
Power over Ethernet (PoE).

When the IP handset is used with the terminal, it communicates 
using Internet protocol between the handset and the terminal. 
However, on the BGAN network side of the terminal, calls are transmitted as circuit switched calls.

When connected to the terminal the IP handset provides a 
dedicated BGAN menu with a subset of the terminal configuration 
options. 

For more information on the functions of the IP handset, refer to the 
user manual for the IP handset.

IP handset

IP data
Circuit 
switched
connection

BGAN network

EXPLORER terminal
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Chapter 1: Introduction
IP cradle

The IP cradle serves as a holder for the IP handset. 

The cradle connects to the coil cord from the handset and, using an Ethernet cable, to the 
terminal.
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Chapter 1: Introduction
The Inmarsat BGAN system

What is BGAN?

The Broadband Global Area Network (BGAN) is a mobile satellite service that offers high-speed 
data up to 492 kbps and voice telephony. BGAN enables users to access e-mail, corporate 
networks and the Internet, transfer files and make telephone calls.

Coverage

The Inmarsat® BGAN services are based on geostationary satellites situated above the equator. 
Each satellite covers a certain area (footprint). The coverage map below shows the footprints of the 
BGAN system as they are after the repositioning of the satellites at the end of february 2009. For 
updated information on coverage, see Inmarsat’s home page at www.inmarsat.com.

Note The map above shows Inmarsat’s expectations of coverage after repositioning of the I4 
satellites. The repositioning is scheduled to be complete by end February 2009. The map 
does not represent a guarantee of service. The availability of service at the edge of 
coverage areas may fluctuate.
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http://www.inmarsat.com


Chapter 1: Introduction
Overview of the BGAN system

A complete BGAN system may include the EXPLORER 727 terminal with connected peripherals, an 
EXPLORER 727 antenna, the BGAN satellite, and the Satellite Access Station (SAS). The satellites 
are the connection between your terminal and the SAS, which is the gateway to the worldwide 
networks (Internet, telephone network, cellular network, etc.).

 

IP Router
PC

Switch Standard voice
and ISDN

EXPLORER

Satellite Access Station
(SAS)

Satellite

Packet Switched Network

Circuit Switched Network

EXPLORER 727
antenna

terminal

IP Handset
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Chapter 1: Introduction
The BGAN services

Supported services

The services currently supported by BGAN comprise:

• A Packet Switched (PS) connection to the Internet

• A Circuit Switched (CS) dialed connection for voice, fax or data

• Short Messaging Service (SMS)

Packet data service

The BGAN network supports different classes of data connection to the Internet. 

• Using a Standard IP connection several users can share the data connection simultaneously. 
This type of connection is ideal for e-mail, file transfer, and Internet and intranet access. The 
user pays for the amount of data sent and received.

• Using a Streaming IP connection you get an exclusive high-priority connection ensuring 
seamless transfer of data. This type of connection is ideal for time critical applications like live 
video over IP. The user pays for the duration of the connection (per minute charge).

Circuit switched (dialed) service

The following types of circuit switched connection are available:

• Standard Voice. A low-tariff connection for voice only. The voice signal is compressed to 
4.0 kbps, which reduces the bandwidth use and consequently the tariff.

• 3.1 kHz Audio. A high quality connection which can be used for Premium Voice, G3 fax or 
analog modems. The signal is uncompressed 3.1 kHz audio, which allows for optimum voice 
quality.

• ISDN. A high quality connection which can be used for voice (3.1 kHz Audio), G4 fax or 64 kbps 
UDI/RDI data. 

SMS service

The BGAN system provides a Short Messaging Service (SMS) for sending and receiving SMS 
messages.

Note The BGAN system supports maximum 11 concurrent PS connections at a time per 
EXPLORER 727 system.

Note The BGAN system only supports one external CS call at a time per EXPLORER 727 system.
98-126882-C The Inmarsat BGAN system 10



Chapter 1: Introduction
Supplementary services

The BGAN system also provides the following supplementary services:

• Call hold

• Call waiting

• Call forwarding

• Voice mail

• Call barring

Limitations

SIM lock

The supplier may SIM lock the terminal to a specific provider. For further information, contact your 
supplier.

Limitations in available services

The services available depend on your airtime subscription. Your SIM card may not allow for all 
the services described in this manual.

Also, some services may not be available at the edge of coverage areas, i.e. in low elevations. For 
further information on coverage, please refer to the Inmarsat home page at www.inmarsat.com.
98-126882-C The Inmarsat BGAN system 11
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Chapter 1: Introduction
Matrix of services and interfaces

The following table shows which equipment and interfaces you can use to access the services 
listed in the left column.

Service
Interface on the terminal

Phone/Fax LAN (PoE) ISDN

Ci
rc

ui
t S

w
itc

he
d

3.1 kHz Audio

Analog telephone IP handset ISDN telephone

G3 Fax machine G4 Fax machine 
(If it supports G3 Fax)

Standard Voice Analog telephone IP handset ISDN telephone

Data, 
UDI or RDI

G4 fax machine or 
computer with ISDN 
modem

Pa
ck

et
 S

w
itc

he
d Data

multi-user
Computer

Data
single-user

Computer

SMS IP handset or computer 
with web interface
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Chapter 2
Getting started 2

In this chapter

This chapter describes how to start up the system and make the first call or data session.

For information on how to install the system, insert SIM card and connect cables, refer to the 
installation manual for the EXPLORER 727 system.

Before you start

Operation at high temperatures

If the terminal is installed in a location where the ambient temperature may rise above 50C, we 
recommend placing the terminal where unintentional contact is avoided. Note that the maximum 
allowed ambient temperature is 55° C.

If the maximum ambient temperature does not exceed 50C, the terminal can be placed in a public 
area.

For further information on installation, refer to the installation manual for the EXPLORER 727 
system.

Connector panel

The drawings below show the connector panel of each terminal version.

Connector panel on EXPLORER 727 terminal:

CAUTION! In very high ambient temperatures, do not touch areas of the 
terminal that are marked with this symbol.

Grounding stud

Power
switch

I/O

DC input

4 x LAN w. PoE

SIM slot

ISDNPhone 1Antenna

Reset button

Phone 2
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Chapter 2: Getting started
Connector panel on EXPLORER 727, 19” Rack terminal:

For information on how to connect to each interface, refer to the installation manual for the 
EXPLORER 727system.

Grounding stud

Power
switch

I/O

DC input

4 x LAN w. PoE

SIM slot

ISDNPhone 1Antenna

Reset button

Phone 2
Terminal
block for
front switch
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Chapter 2: Getting started
Starting up the terminal

SIM card

Note that the EXPLORER 727 terminal requires a SIM card dedicated to the land vehicular BGAN 
service. The terminal can only access the BGAN network when the right type of SIM card is 
installed. For information on how to insert the SIM card, refer to the installation manual.

Switching on the terminal

Using the Power switch

To switch on the terminal, use the On/Off switch in the connector panel. It normally takes one or 
two seconds for the terminal to switch on.

Note If you have the 19” Rack variant of the EXPLORER terminal, you can use the on/off switch 
in the front panel. See the next section 19” Rack terminal: Using the front power switch.
98-126882-C Starting up the terminal 15



Chapter 2: Getting started
19” Rack terminal: Using the front power switch

If you have the  19” Rack variant of the EXPLORER terminal, tip the switch in the front panel to “1” 
to switch on the terminal.

Using the ignition system

If you have connected the ignition system of your vehicle to the I/O connector, you may leave the 
power switch in the “on” position and the terminal will switch on/off when you start/stop the 
engine of your vehicle. 

When the engine is stopped the terminal is in standby mode, meaning that only the primary parts 
of the system are kept alive. The standby current is max. 15 mA when the ignition is off. For 
information on how to connect to the I/O connector, refer to the installation manual for the 
EXPLORER 727 system.

You must set up the ignition function in the web interface. For further information, see Configuring 
the I/O interface on page 81.

Note To be able to use the power switch on the front panel, you must leave the On/Off switch 
in the connector panel in the On position.

Note If you have the 19” Rack terminal, you must leave both power switches in the “on” 
position to make use of the ignition function.

Note In some cases, the system may reboot after power-on because of the high start-up 
current.
98-126882-C Starting up the terminal 16



Chapter 2: Getting started
Using a remote on/off switch

If an external switch is connected to the remote on/off pins in the DC connector, you may leave the 
power switch in the connector panel in the “on” position and use the remote switch to turn the 
terminal on and off. When the remote switch is off, the terminal is off. However, if you leave the 
power switch on the terminal in the “on” position, you can always switch the terminal back on 
with the remote switch. The standby current when the remote switch is off is max. 2 mA. For 
further information on the remote on/off function, refer to the installation manual for the 
EXPLORER 727 system.

Power up completed

When the terminal is switched on, the Power indicator in the LED panel of the terminal lights 
green.

You can now access the terminal settings, but the terminal is not ready for making calls or running 
data sessions until the system is registered on the BGAN network. You may have to enter a SIM 
PIN before the system can register. For further information, see Entering the SIM PIN for the 
terminal on page 21 and Registering on the BGAN network on page 23.

To switch off the terminal tip the Power switch back. It takes 5 to 10 seconds to power down the 
terminal. Alternatively use the ignition or remote on/off function described above.

Note In the 19” Rack version of the terminal the remote on/off function is normally not 
available, because it is used for the front switch.
98-126882-C Starting up the terminal 17



Chapter 2: Getting started
Connecting the IP handset

Power supply (PoE)

The Thrane IP Handset is powered from the LAN interface, using Power over Ethernet.

The total output power from all 4 interfaces is

• 64 W at 24 V DC power supply

• 32 W at 12 V DC power supply

All interfaces can support devices of power class 1, 2 and 3 (4, 7 and 15.4 Watt), as long as the total 
power consumption does not exceed the above limits. If the limits are exceeded, the LAN ports are 
prioritized so that LAN port 1 has the highest priority. For example, if all ports are used and the 
total power consumption is too high, port 4 is closed down.

In case of power hold-up (failure on input power), PoE will be turned off.

Starting up the IP handset

The following procedure is for the Thrane IP Handset. The procedure may be different for another 
type of IP handset.

Do as follows:

Connect the cable from the Thrane IP Handset/cradle to one of the LAN (PoE) connectors on the 
terminal as described in the user manual for the handset.

The handset starts up automatically.

When the display shows this symbol in the upper right corner, the handset is ready for 
making a call.

If the handset is not ready for making calls, the reason may be that the BGAN terminal is waiting 
for a SIM PIN. To check this, enter the handset menu system and select BGAN > Status > PIN 
status.

Note The first handset that is connected to the LAN interface on the terminal is automatically 
registered in the terminal and assigned the local number 0501 and password 0501. For 
information on how to connect additional handsets, see Connecting a new IP handset on 
page 77.
98-126882-C Connecting the IP handset 18



Chapter 2: Getting started
Entering the SIM PIN for the terminal

If the SIM card in your terminal requires a PIN and the PIN has not yet been entered in the 
terminal, you can enter the PIN from the BGAN menu of the IP handset.

To enter the PIN for the terminal, do as follows:

1. Select BGAN > Enter PIN code from the handset menu system. Note that this menu item is only 
available if the terminal is waiting for a PIN. 

2. Enter the administrator user name and password for the terminal followed by the PIN for the 
terminal. 

For further information on the IP handset, refer to the user manual for the handset.
98-126882-C Connecting the IP handset 19



Chapter 2: Getting started
Connecting a computer

Before connecting to the LAN interface

For the LAN interface to work without any further setup, the connected computer must be set up to 
obtain an IP address and a DNS server address automatically.

To check this on your computer (WIndows XP), do as follows:

1. Go to Start > Settings > Control Panel > Network Connections.

2. Right-click on the LAN connection you want to use.

3. Select Properties, highlight Internet Protocol (TCP/IP).

4. Click Properties. 

5. Make sure that the following is selected:

• Obtain an IP address automatically

• Obtain DNS server address automatically

Connecting a computer to the LAN interface

Do as follows:

1. Power up your computer.

2. Connect your LAN cable between the network connector on your computer and one of the LAN 
connectors on the terminal.
When the computer and the terminal are ready, the terminal automatically starts a Standard 
data connection. You can now browse the Internet, check your email or accessthe built-in web 
interface of the terminal with your browser (enter the IP address, by default http://192. 168.0.1, 
in the address bar of the browser). For further information, see Accessing the web interface on 
page 44.

For information on how to configure the LAN interface on the terminal, see Configuring the LAN 
interface on page 63.

Note This section only describes a Standard Internet connection with default settings on the 
terminal. For information on other scenarios, see Connecting to the Internet on page 38.
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Chapter 2: Getting started
Entering the SIM PIN for the terminal

Overview

Depending on your SIM card, you may have to enter a SIM PIN to use the system. You can enter 
the PIN using a standard phone or ISDN phone, the IP handset or the web interface.

For information on how to connect the IP handset or computer you are going to use, see 
Connecting a computer to the LAN interface on page 20 or Connecting the IP handset on page 18.

Entering the PIN using a phone or IP handset

To enter the PIN

If you have a phone connected to the terminal, you can use it to enter the PIN at start up.

Do as follows:

• For an analog or ISDN phone: 
Pick up the phone. When the terminal is waiting for a PIN, you will hear 2 beeps - pause - 2 
beeps - etc.
Dial <PIN> followed by #.
When you hear a “busy” tone or a dialing tone, the PIN has been accepted and you can hang 
up or dial a number.

• For an IP handset: 
Select the BGAN menu, select Enter PIN and enter the user name and password for the 
terminal. Then enter the PIN for the terminal. 
Note that the menu item “Enter PIN” is only available if the terminal is waiting for a PIN.

Wrong PIN

Analog phone or ISDN phone: If, instead of the busy tone or dialing tone, you continue to hear 2 
beeps - pause - 2 beeps - etc., it means the PIN was not accepted. Check that you have the correct 
PIN and try again.

If a wrong PIN has been entered three times, you will hear 3 beeps - pause - 3 beeps - etc. This 
means you have to enter the PUK (PIN Unblocking Key) provided with your SIM card. 
After entering the PUK, you must enter a new PIN of your own choice (4 to 8 digits long).

Dial the following:

<PUK> * <New PIN> * <New PIN> followed by # or off-hook key.

Example: If the PUK is 87654321 and the new PIN is 1234, dial
87654321 * 1234 * 1234 followed by # or off-hook key.

If you enter 10 wrong PUKs, the SIM card will no longer be functional. Contact your Airtime 
Provider for a new SIM card.

IP handset: After having entered the user name and password for the terminal you have 3 attempts 
to enter the SIM PIN, before you are asked to enter the PUK (Pin Unblocking Key). The PUK is 
supplied with the SIM card for your terminal. 
98-126882-C Entering the SIM PIN for the terminal 21



Chapter 2: Getting started
Enter the PUK followed by a new PIN of your own choice. The PIN must be from 4 to 8 digits long.

If you enter a wrong PUK 10 times, the SIM card will no longer be functional, and you have to 
contact your Airtime Provider for a new SIM card.

Entering the PIN using the web interface

To enter the PIN

Do as follows:

1. On a computer connected to the terminal, open your browser and enter the IP address of the 
terminal. Refer to Using the web interface on page 42.
The default IP address is 192.168.0.1.
If your SIM card uses a PIN and the PIN has not yet been entered, the web interface will open 
on the PIN page.

2. Type in the PIN and click OK.
When the PIN is accepted, the web interface opens the Dashboard and is ready for use. If the 
PIN is not accepted, see the next section Wrong PIN.

Wrong PIN

You have 3 attempts to enter the PIN in the web interface, before you are asked to enter the PUK 
(Pin Unblocking Key). The PUK is supplied with your SIM card. 
Enter the PUK followed by a new PIN of your own choice. The PIN must be from 4 to 8 digits long.

If you enter a wrong PUK 10 times, the SIM card will no longer be functional, and you have to 
contact your Airtime Provider for a new SIM card.
98-126882-C Entering the SIM PIN for the terminal 22



Chapter 2: Getting started
Registering on the BGAN network

Registration procedure

When the SIM PIN is accepted by the terminal, the EXPLORER 727 system starts the registration 
procedure on the BGAN network.

You can monitor the registration procedure by looking at the Antenna and Terminal indicators in 
the LED panel of the terminal.

Note that the registration procedure may take several minutes. The table on the next page shows 
the normal sequence.

LED indications during the registration procedure

This table shows how the startup procedure is signaled with the light indicators. If an error occurs, 
the indicators will light yellow or red, depending on the severity of the error.

For further information on the indicators, see Light indicators on page 123.

Note on satellite coverage

Be aware that if the vehicle is placed on the side of a steep hill or similar, you may not have 
optimum satellite coverage because the elevation angle of the antenna is changed.

Note We recommend keeping the vehicle on a steady course while the antenna is performing 
a sky scan. If the vehicle is turning during sky scan, it increases the total duration of the 
sky scan process.

Status Antenna indicator Terminal indicator

The antenna is starting up Flashing slowly green

The antenna is performing a sky scan Flashing rapidly green

The terminal is registering on the network Flashing green

The antenna is tracking. Steady green

The system is registered and ready for use. Steady green Steady green
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Making the first call

Introduction

When the Antenna and Terminal indicators in the LED panel on the terminal both light steady 
green, you are ready to make or receive the first call.

The following sections provide a short guide to making calls. For more detailed information, see 
Making or receiving a phone call on page 29.

Making a call from the terminal

To make a call from a phone or handset connected to the terminal, dial

00 <country code> <phone number> followed by # or off-hook key.

Example: To call Thrane & Thrane in Denmark (+45 39558800) from an analog phone, 
dial 00 45 39558800 #

Making a call to the terminal

To make a call to a phone connected to the terminal, dial

+ <Mobile number>

• + is the prefix used in front of the country code for international calls.

• Mobile number: The mobile number of the terminal you are calling. The first part of the 
number is always 870, which is the “country code” for the BGAN system.

Example: If you are calling from Denmark and the mobile number for Standard Audio is 
870772420567 on your terminal, and you want to make a call to the terminal using 
Standard Audio, dial 00 870 772420567.

If the mobile numbers are listed in the web interface, you can look them up by selecting PHONE 
BOOK > Mobile numbers. 
If the numbers are not listed, refer to your airtime subscription. We recommend using the web 
interface to save the mobile numbers for future reference. See Viewing and editing the mobile 
numbers on page 53.

Making a call from one terminal to another

To make a call from one terminal to another, dial 00 <Mobile number>.

Note By default all handsets connected to the terminal will ring on incoming calls. If you have 
connected a fax, set the incoming call type on that Phone/Fax interface to 3.1 kHz Audio 
to avoid that the fax rings and answers an incoming Standard call. For further 
information, see Selecting the call type on page 28.

Note There are two Voice numbers, one for 3.1 kHz Audio and one for Standard Voice.
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In this chapter

This chapter describes how to use the EXPLORER 727 system.

It does not describe advanced configuration of interfaces. For this type of information, refer to the 
“Configuring...” sections for the interfaces in Chapter 4, Using the web interface.

General

Tools for setup and use

Overview

You can use the Thrane IP Handset for viewing status, using the phone book of the terminal and 
for entering the PIN, but for enhanced use and for configuration of interfaces, you need to connect 
a computer.

With a computer and a browser, you can use the built-in web interface to set up the terminal.

The IP handset

When you connect the Thrane IP Handset to one of the LAN (PoE) connectors on the terminal you 
can use the handset display and keypad to enter the PIN or to view the status of the terminal. 

The menu system in the IP handset includes the following items for the terminal:

• Viewing C/No (signal strength) and status (“Ready”, “Registering” etc.) for the EXPLORER 727 
system.

• Viewing the IP address and software version of the terminal.

• Viewing the IP handset settings from the terminal.

• Entering the PIN and PUK for the terminal.

• Inclusion of the EXPLORER phone book (not editable) in the IP handset Contacts.

For further information, see the user manual for the IP handset.

The web interface of the terminal

The web interface is a built-in web server for setting up and controlling the terminal, using a 
connected computer with a browser. No installation of software is required. 

With the web interface you can access the same settings as with the IP handset, and additionally:
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• edit the phone book

• view information on calls to/from the terminal

• view properties of the terminal and antenna

• set up the interfaces of the terminal

• upload software

• set up user rights (requires administrator password)

• set up network user groups (requires administrator password)

For information on how to use the web interface, see Using the web interface on page 42.

Services and interfaces

The following table shows which equipment and interfaces you can use to access the services 
listed in the left column.

Service
Interface on the terminal

Phone/Fax LAN (PoE) ISDN

Ci
rc

ui
t S

w
itc

he
d

3.1 kHz Audio

Analog telephone IP handset ISDN telephone

G3 Fax machine G4 Fax machine 
(If it supports G3 Fax)

Standard Voice Analog telephone IP handset ISDN telephone

Data, 
UDI or RDI

G4 fax machine or 
computer with ISDN 
modem

Pa
ck

et
 S

w
itc

he
d Data

multi-user
Computer

Data
single-user

Computer

SMS Computer with web 
interface
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Using a phone or fax machine

Available interfaces

Three types of voice equipment connect to the terminal:

Standard analog phone or G3 fax machine: The terminal has two phone connectors for connecting 
standard analog phones or fax machines.

IP handset: The terminal has four LAN connectors with Power over Ethernet for connecting IP 
handsets or other IP equipment. For information on the features and functions of the Thrane IP 
Handset, refer to the user manual for the handset.

ISDN phone or G4 fax machine: The terminal has one ISDN connector for connecting an ISDN 
phone, a modem or a fax machine. 

For information on how to connect to the interfaces, see the installation manual for the 
EXPLORER 727 system.

Port 1 Port 2
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Selecting the call type

Definition

The phone connection can use one of the following call types:

• Standard Voice, which is a low-tariff voice connection compressed to 4.0 kbps,

• 3.1 kHz Audio, which is a high quality connection used for Premium Voice, G.3 fax or analog 
modem,

• UDI or RDI (only on ISDN interface), which is used for G4 fax or data.

In the web interface you can set up which type of connection to use by default when you make or 
receive a call from the Phone/Fax or ISDN interface or from an IP handset connected to the LAN 
interface.

When connecting a fax or a modem to the Phone/Fax interface you must use 3.1 kHz Audio.

Example: If you always have a fax connected to the same Phone/Fax interface you can set this 
interface to 3.1 kHz Audio only. This will mean that if an incoming Standard Voice call is 
received, this Phone/Fax interface will not ring.

When connecting a G4 fax or a modem to the ISDN interface in the EXPLORER 727 system you must 
use UDI.

Selecting the default outgoing call type

To select the default call type for outgoing calls, do as follows:

• ISDN. Select the call type in the web interface under SETTINGS > ISDN. 
For further information, see Configuring the ISDN interface on page 67.

• Phone/Fax. Select the call type for each port in the web interface under SETTINGS > 
Phone/Fax. 
For further information, see Configuring the Phone/Fax interface on page 66.

• IP handset. Select the call type for each handset in the web interface under SETTINGS > 
IP Handset > Call settings. For further information, see Setting the call types for IP handsets on 
page 79.

Overriding the default outgoing call type

To override the default setting for a specific outgoing call, do as follows:

• To use Standard Voice for the call,
dial 1* before the number. 

• To use 3.1 kHz Audio for the call,
dial 2* before the number.
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Example: To make a call to Thrane & Thrane in Denmark (+45 39558800), forcing the connection 
to use Standard Voice, dial 1* 0045 39558800 followed by # if calling from an analog or 
ISDN phone, or off-hook key if calling from an IP handset.

Phone numbers for incoming 3.1 kHz Audio and Standard Voice

3.1 kHz Audio and Standard Voice have separate phone numbers. This way, a person calling a 
phone connected to the terminal can select whether to use 3.1 kHz Audio or Standard Voice by 
using the dedicated phone number.

If the mobile numbers are listed in the web interface, you can look them up as follows:

Connect a computer, access the web interface and select PHONE BOOK > Mobile numbers. For 
further information, see Viewing and editing the mobile numbers on page 53.

If the mobile numbers are not available in the web interface, refer to your airtime subscription.

For information on how to make a call to the terminal, see Making a call to the terminal on 
page 31.

Selecting the incoming call type

To select which call types are accepted for an incoming call, use a computer and the web interface.

• ISDN. Select the call type under SETTINGS > ISDN. 
For further information, see Configuring the ISDN interface on page 67.

• Phone/Fax. Select the call type for each port under SETTINGS > Phone/Fax. 
For further information, see Configuring the Phone/Fax interface on page 66.

• IP handset. Select the call type for each handset in the web interface under SETTINGS > 
IP Handset > Call settings. For further information, see Setting the call types for IP handsets on 
page 79.

Making or receiving a phone call

Analog phone, ISDN phone or IP handset

There are different methods for activating a call, depending on the type of phone:

• Analog phone or ISDN phone: Dial # after the number.

• IP handset: Press the off-hook key after the number.

Note This will not change the default call type, only the type used for the ongoing call.

Note The call type you are using must be selected in the web interface (refer to the next 
section).

Note There are two Voice numbers, one for 3.1 kHz Audio and one for Standard Voice.
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Making a call

First connect your phone to the relevant interface. For further information, see the Installation 
Manual.

You have different options for making a call:

• Short Dial. If the number is in the phone book of the terminal, you can use the Short Dial 
number, which is found in the first column of the phone book in the web interface. See Short 
dial on page 52.
Simply dial 00 <Short Dial> followed by # or off-hook key.

Example: To call entry number 4 in the phone book, 
dial 004 followed by # or off-hook key.

• Manual Dial. To make a call, dial
00 <country code> <phone number> followed by # or off-hook key.

Example: To call Thrane & Thrane in Denmark (+45 39558800) from an analog or ISDN 
phone, dial 00 45 39558800 #

• Call from phone book or call log (only IP handset). 

• Enter the phone book of the IP handset, scroll to the wanted number and press the off-hook 
key, or

• press the off-hook key from the main screen to display the latest calls in the call log. Then 
scroll to the wanted number and press the off-hook key again. 
Note that this is the call log of the IP handset, not of the terminal.

If there was an error establishing the connection, refer to the Troubleshooting Guide on page 119.

If you are using the IP handset, the handset may show an error message.
Depending on the type of error, the web interface may also show an error message. See Viewing 
the Event list or the Event log on page 114.

Receiving a call

To be able to receive a call, the phone must be connected to the relevant interface on the terminal. 

By default, all devices connected to the Phone/Fax interface, the ISDN interface or the LAN (PoE) 
interface will ring when one of the mobile numbers is called. Note, however, that this depends on 
the call type settings. Refer to Selecting the incoming call type on page 29.

Call log

Information of missed calls is stored in the call log of the terminal. You can view the call log in the 
web interface under CALLS. For further information, see Viewing the lists of calls on page 55.
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Making a call to the terminal

To make a call to a phone connected to the terminal, dial 

+ <Mobile number>

• + is the prefix used in front of the country code for international calls.

• Mobile number. The first part of the mobile number is always 870, which is the “country code” 
for the BGAN system. If the mobile numbers are listed in the web interface, you can look them 
up as follows:
Connect a computer, access the web interface and select PHONE BOOK > Mobile numbers. For 
further information, see Viewing and editing the mobile numbers on page 53.
If the mobile numbers are not available in the web interface, refer to your airtime 
subscription.

Making local phone calls

You can make local calls between various phones connected to the terminal.

Local phone numbers always start with 0.

For an overview of the numbers assigned to each type of interface, see Local numbers and special-
purpose numbers on page 32.

To make a local call, dial
<local number> followed by # or off-hook key.

Note There are two Voice numbers, one for 3.1 kHz Audio and one for Standard Voice.

Note If you are using local numbers for ISDN devices, the numbers must be programmed in 
the devices. For further information refer to the documentation for your ISDN device
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Dialing functions

Local numbers and special-purpose numbers

There are a number of dialing functions available in the terminal. The following list shows the 
allocated special-purpose numbers for the terminal.

Number Function

0 * followed by # or off-hook 
key

Redial last called number on this 
interface.

00 * followed by # or off-hook 
key

Redial last answered call on this 
interface.
Note: If the last answered number is an 
unlisted number, you will not be 
allowed to dial back.

00 followed by one of the 
numbers 1-199 and # or off-
hook key

Short dial phone numbers in phone 
book.

0300 followed by # or off-hook 
key

Local call broadcast to both analog 
phones.

0 followed by one of the 
numbers 
301-302 and # or off-hook key 

Local call to analog phone. 

0400 followed by # or off-hook 
key

Local call broadcast to all ISDN phones.

0 followed by one of the 
numbers 
401-402 and # or off-hook key

Local call to ISDN phone.

0500 followed by # or off-hook 
key

Local call broadcast to all IP handsets.

0 followed by one of the 
numbers 
501-516 and # or off-hook key

Local call to IP handset.

0900 followed by # or off-hook 
key

Local call broadcast to all handsets.
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Dialing prefixes

Apart from the numbers above, the terminal uses the following dialing prefixes:

• 1* before the phone number will force the connection to use Standard Voice.

• 2* before the phone number will force the connection to use 3.1 kHz Audio.

• #31# before the phone number will hide the callers phone number to the recipient.

• *31# before the phone number will show the callers phone number to the recipient where it 
would otherwise be hidden, e.g. because the number is an ex-directory number.

• R is used during a call to indicate that the following key-presses should activate a 
supplementary services function. The supplementary services functions supported by the 
terminal are described in the subsequent sections.

Handling waiting calls

During a call, if a second party attempts to make contact with you, you may hear a Call Waiting 
indication. The Call Waiting indication is two beeps and a pause of 3 seconds, then two beeps 
again etc. If no action is taken, the waiting call is released after a time out period.

In the web interface you can enable or disable the call waiting indication. For further information, 
see Call waiting on page 74.

When you receive a Call Waiting indication, you have the following options:

Note The phone must have an R key to be able to use these 
functions.

If you want to: Do as follows:

Clear the current call,
and accept the waiting 
call.

Press R 1 #, within the time out period.

Hold the current call,
and accept the waiting 
call.

Press R 2 #, within the time out period.

Ignore the waiting call. Take no action.

Reject the waiting call. Press R 0 #, within the time out period.

Note The BGAN system only supports one external call at a time.
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Holding a call

During a call, you may place the initial call on hold while another call is made. 

Transferring a call

When you receive a call, you can transfer this call to another phone connected to the terminal.

To transfer the incoming call to another phone or headset, do as follows:

1. Press R 4 * <local number> #.
The phone with the local number you dialed starts to ring. 

2. You now have two options.

• Hang up. The phone or headset you transferred the call to continues to ring. When the call 
is answered, a connection is established between the initial caller and the new recipient.

• Do not hang up. When the new recipient answers, you can have a conversation before 
hanging up. When you hang up, the call is handed over to the initial caller.

Note The phone must have an R key to be able to use these 
functions.

If you want to: Do as follows:

Place a call on hold. Press R 2 #.

Place the existing call on 
hold and establish a new 
call.

Press R and dial the second phone 
number followed by #.

Shuttle between the two 
calls.

Press R 2 #
(irrespective of whether the second call 
was acquired using Call Hold or 
acceptance of Call Waiting.)

Clear the held call, if no 
waiting call exists.

Press R 0 #.

Clear an active call and 
return to the held call.

Press R 1 #. 
Note that this is only possible if no 
waiting call exists.

Note The BGAN system only supports one external call at a time.

Note The phone must have an R key to be able to use these 
functions.

Note The BGAN system only supports one external call at a time.
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Sending or receiving a fax message

Handling delays

When sending or receiving fax messages over satellite, both fax units must be capable of handling 
longer delays without timing out. Some fax machines have an Overseas mode, which enables the 
unit to handle the long delays.

Sending a fax message from the terminal

The fax machine must be connected to the Phone/Fax interface or the ISDN interface of the 
terminal. Refer to the installation manual.

3.1 kHz Audio must be used for an analog fax machine. Refer to Selecting the default outgoing call 
type on page 28.

UDI must be used for an ISDN G4 fax machine. Refer to Configuring the ISDN interface on page 67. 

To send a fax from a fax machine connected to the terminal, dial 
00 <country code> <phone number> #

Example: To send a fax to Thrane & Thrane in Denmark (+45 39558888), 
dial 00 45 39558888 #

Note If the default setting in the web interface is not 3.1 kHz Audio, you can dial 2 * before the 
number to force the connection to use 3.1 kHz Audio. For further information, see 
Overriding the default outgoing call type on page 28.
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Sending a fax message to the terminal

To send a fax message to the terminal, dial

+ <Mobile number> #

• + is the prefix used in front of the country code for international calls.

• Mobile number. The first part of the mobile number is always 870, which is the “country code” 
for the BGAN system. Use the 3.1 kHz mobile number if you are calling a G3 fax and the UDI 
number if you are calling an ISDN G4 fax connected to the terminal. If the mobile numbers are 
listed in the web interface, you can look them up as follows:
Connect a computer, access the web interface and select PHONE BOOK > Mobile numbers. For 
further information, see Viewing and editing the mobile numbers on page 53.
If the mobile numbers are not available in the web interface, refer to your airtime 
subscription.

Receiving a fax message

An analog fax machine connected to the terminal can only receive a fax with 3.1 kHz Audio. Refer 
to Selecting the incoming call type on page 29.

An ISDN G4 fax machine connected to the EXPLORER 727 terminal can only receive a fax with UDI.

Note There are four mobile numbers, one for 3.1 kHz Audio, one for Standard Voice, one 
for UDI and one for RDI.
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Using a computer

Interfaces

The terminal has four LAN connectors for connecting computers or other LAN equipment.

For information on how to connect to the interfaces, see the installation manual for the 
EXPLORER 727system.

Standard IP or Streaming IP on LAN

The BGAN network supports different classes of data connection to the Internet. The main classes 
are Standard IP and Streaming IP.

• Using a Standard IP connection, several users can share the data connection simultaneously. 
This type of connection is ideal for TCP/IP traffic such as e-mail, file transfer, and Internet and 
intranet access. 
The user pays for the amount of data sent and received.

• Using a Streaming IP connection, you get an exclusive, high-priority connection, ensuring 
seamless transfer of data. This type of connection is ideal for time critical applications like live 
video over IP.
The user pays for the duration of the connection (per minute charge).

You can set up various types of connection using the profiles and traffic flow filters. For further 
information, see Using profiles on page 106 and Using traffic flow filters on page 109.

Note For optimum performance it is important that you select the right traffic class when 
defining profiles for your connection.
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Working with network user groups

The LAN users of the EXPLORER 727 system can be organized in network user groups with 
different setup and different access rights. 

The network user group you belong to is determined by one or more of the following:

• the LAN port you connect to

• the IP address of the device you are using

• the MAC address of the device you are using

Non-administrator users can only see and start/stop profiles configured for their own network 
user group.

Using the web interface and administrator password you can configure the network user groups 
and network devices. For further information, see Managing LAN network users on page 82.

Connecting to the Internet

Default setup

By default, any IP device that is connected to the terminal belongs to the Default network user 
group. It uses a Standard shared IP connection, which is automatically activated. Note that this 
setting may result in unintended use of bandwidth (see the next section). For further information 
on network user groups, see Managing LAN network users on page 82.

Unintended use of bandwidth

The system default setting is automatic activation of a standard data connection. Then you connect 
the PC to the network and start using the applications. You do not have to connect to the web 
interface to start using the services, it is plug-and-play. This setting involves a high risk of being 
charged for airtime and bandwidth when connected computers perform automatic software 
updates. 

To avoid unintended use of bandwidth through automated background services the terminal can 
be set to not automatically connect to the Internet when you connect your computer or other IP 
equipment (PDA, webcam, etc.). to the network interface. You set this in the web interface. These 
automatic background services could be Windows update downloads or checking for e-mails 
automatically at short time intervals. 

If you want to start a data connection in this mode you must access the system’s web interface and 
activate your data session, standard IP and/or streaming IP, from the Dashboard.

Note Software updates should only be performed when you are 
connected at the office or at home where bandwidth and 
airtime are less costly. 

Note Optimize airtime and bandwidth usage: You are charged for 
the bandwidth used for automatic PC software updates. We 
recommend to disable this feature in your computer.
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Accessing your data sessions

Data sessions available for the current user are displayed under PROFILES ON LAN or STREAMING 
PROFILES ON LAN at the bottom of the Dashboard.

• Primary profiles are listed in the left side and secondary profiles (if any) are listed to the right.

• Profiles that are currently active are displayed as a link with the text “Stop <name of profile>”. 

• Profiles ready to be activated are displayed as a link with the text “Start <name of profile>”. 

Start/stop Standard IP on the LAN interface

By default, Standard IP is always activated on the terminal. If you only want Standard data to be 
activated when you have specifically enabled it, you can disable automatic activation under 
SETTINGS > LAN > Network user groups.

When automatic activation is disabled in the Network user groups page, you can manually 
start/stop your Standard IP profile from the Dashboard by clicking Start <name of profile> or Stop 
<name of profile> under PROFILES ON LAN at the bottom of the page.

If a primary profile is already active, your new profile will not appear as a link but as plain text. 
The active primary profile is displayed as a link with the text “Stop <name of profile>”. Click this 
link first to stop the active profile. Then click your new profile, which is now displayed as a link.

Note To manage data sessions for all users you need an administrator password. For further 
information, see Starting/stopping data sessions on page 94.

Note If another primary profile is active you must stop it before you can start your new profile.
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Start/stop Streaming IP on the LAN interface

To start or stop a Streaming session, click the link with the name of your Streaming profile under 
STREAMING PROFILES ON LAN.

Note that if another primary profile is active you must stop it before you can start your new 
profile!

If a primary profile is already active, your new profile will not appear as a link but as plain text. 
The active primary profile is displayed as a link with the text “Stop <name of profile>”. Click this 
link first to stop the active profile. Then click your new profile, which is now displayed as a link.

For information on setup of the network user groups, see Managing LAN network users on 
page 82. For information on how to set up a profile, see Using profiles on page 106.

The EXPLORER 727 system supports 32, 64, 128 and 256 kbps Streaming.

Note The Streaming link is only available if your network user group includes a Streaming 
profile. See Editing a network user group on page 84.

Important If you have selected a Streaming connection as your primary profile, the LAN 
interface will be running a Streaming connection until you stop it or disconnect the 
interface. However, if you select one or more secondary profiles, you can set up 
your traffic flow filter so that it will only use the Streaming profile for certain types 
of traffic.

Note You may not be able to establish the fastest Streaming connection if you are located 
close to the edges of the satellite beam. 256 kbps Streaming normally requires an 
elevation angle of more than 15 degrees.
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Using the IP handset

You can use the Thrane IP Handset as user interface for the EXPLORER 727 system as well as for 
making calls or sending SMS messages.

The IP handset has a dedicated menu for the EXPLORER 727 system. You find a list of the menu 
items available in The IP handset on page 25.

For information on how to start up the IP handset, see Connecting the IP handset on page 18.

For further information on how to use the IP handset, refer to the IP Handset User Manual.
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Using the web interface 4

In this chapter

This chapter describes how to use the web interface to operate, set up and configure your 
EXPLORER 727 system.

Introduction

The web interface

What is the web interface?

The web interface is built into the terminal and is used for operating, setting up and configuring 
the system. 

You can access the web interface from a computer with a standard Internet browser. The following 
browser versions were tested successfully:

• Internet Explorer 6.0 and 7.0

• Mozilla Firefox 2.0

• Apple Safari 2.0

You may be able to use other browser versions as well.
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Proxy settings when accessing the web interface

If you are connecting your computer using a LAN or WLAN interface, the Proxy server settings in 
your browser must be disabled before accessing the web interface. Most browsers support 
disabling of the Proxy server settings for one specific IP address, so you can disable Proxy server 
settings for the web interface only, if you wish. Consult your browser help for information.

To disable the use of a Proxy server completely, do as follows:

1. In Microsoft Internet Explorer, select Tools > Internet Options > Connections > LAN Settings.

2. Clear the box labeled Use a proxy server for your LAN. 

3. Click OK.

When the proxy server settings are disabled, close your browser.

You may need to change this setting back on return to your Internet connection.
 

Note The following description is for Microsoft Internet Explorer. If 
you are using a different browser, the procedure may be 
different.
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Accessing and navigating the web interface

Accessing the web interface

To access the web interface, do as follows:

1. Connect your computer to the terminal.

2. Start up the terminal. 
For further information, see Getting started on page 13.

3. Open your browser and enter the IP address of the terminal.
The default IP address is http://192.168.0.1.

Changing the language

When you have access to the web interface, if you want to display a different language than 
English, select SETTINGS > LANGUAGE from the left menu, select a language from the list and click 
Apply. For further information, see Selecting the language on page 99.

Note If the IP address is changed and you do not have the new address, you can temporarily 
set the IP address to the default value by pressing the Reset button next to the SIM slot in 
the connector panel of the terminal. You can then access the web interface and change 
the IP address.

Note that if you do not change the IP address, the default IP address will only be valid 
until the terminal is powered off. Then the terminal returns to the IP address from before 
the Reset button was pressed. 

For further information on the Reset button, see Reset button on page 134.
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Overview of the web interface

When the web interface opens, the title bar shows the name of the product.

The web interface consists of the following sections.

• The navigation pane holds the main menu. Clicking an item in the menu opens a submenu in 
the navigation pane or a new page in the contents section.

• The status field shows the signal strength.

• The icon bar shows icons for new SMS messages and for active events, when relevant. For 
explanations of the icons, see the next section, Icons in the icon bar.

• The contents section shows the page selected in the navigation pane. This section is used for 
viewing or changing settings, or for performing actions.

Navigation

Status

Icon bar Contents section

pane

field

Title bar
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Icons in the icon bar

The following icons may appear in the icon bar in the web interface:

Navigating the web interface

• To expand a menu, click the menu in the navigation pane. 

• To access status and settings, click the relevant subject in the navigation pane or click the 
relevant icon in the icon bar. The status or settings are displayed in the contents section.

• To see the site map, click SITE MAP in the navigation pane. The site map lists all topics and 
submenus. Click on items in the site map to go directly to the relevant location.

Icon Explanation

A new SMS message, or information of Voice mail, has 
arrived.

Click the icon to see new messages or information of Voice 
mail. For further information, see Receiving a message on 
page 58.

An event is active.

Click the icon to see a list of active events. For explanations 
of the event messages, see List of events on page 127.

Note that this icon will remain in the icon bar as long as the 
event is still active.
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Entering the SIM PIN in the web interface

Do you need a SIM PIN?

If a computer is connected when you start up the terminal, you can access the web interface and 
enter the SIM PIN here.

To enter the SIM PIN

If your SIM card requires a PIN, and the PIN has not yet been entered: When you access the web 
interface, it opens on the PIN page. Until you have entered the PIN you can only upload software 
and view the Dashboard. Access to all other parts of the web interface requires a PIN.

Type in the PIN and click OK.

If you enter a wrong PIN 3 times you are asked for a PUK (PIN Unblocking Key). For further 
information, see Wrong PIN on page 22.

If the PIN has already been entered in the terminal, or the PIN is disabled, the web interface goes 
directly to the Dashboard at start-up. 

When the correct PIN has been entered, the web interface opens the Dashboard and is ready for 
use.

Note You may not have to enter a SIM PIN to access the terminal. This depends on whether or 
not the use of a SIM PIN is enabled on your SIM card. 

Note Some parts of the web interface may be greyed out if the user permissions are limited. 
For information on how to set up user permissions, see Setting up user permissions on 
page 112.
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Using the Dashboard

Overview

The Dashboard is used for control and inspection of ongoing communication and for viewing 
properties and status of the terminal and antenna.

For information on how to start or stop your data sessions from the Dashboard, see Connecting to 
the Internet on page 38.
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Properties

The PROPERTIES section of the DASHBOARD shows the following information:

• Airtime provider. The name of your Airtime Provider.

• GPS position. The GPS position of your EXPLORER 727 system.

• Status. The status of the terminal and antenna.
Examples of status information are: Scanning, Ready and Data active.

• Satellite selection. The satellite selected for logon. For further information, see Selecting the 
preferred BGAN satellite on page 98.

• Unit serial number. The serial number of the terminal.

• Software version. The version of the software embedded in the terminal.

• Local IP address. The local IP address of the terminal. This is the IP address used to access the 
terminal from a device connected to the terminal.

• IMEI number. The IMEI number (International Mobile Equipment Identity) of the terminal. This 
is a unique number that identifies your terminal.

• MAC address for the LAN interface in the terminal.

• Antenna. Thestatus of the antenna.

Viewing information on calls and data sessions

The following sections in the Dashboard show information on calls and data sessions.

• ONGOING CALLS is a list of calls that are currently active. The list shows the call type and the 
time connected for each call.

• ONGOING DATA SESSIONS is a list of data profiles that are currently active, including the IP 
address that is assigned to each profile.

• SESSIONS TOTAL lists the totals for each connection. The list shows the time connected 
(hh:mm:ss) for voice and Streaming IP, and MB transferred for Standard data.

Note In some cases, the BGAN network does not allow the position to be displayed to the 
user. If this is the case, the display may just show GPS acquired. This means that the 
GPS position is received, but the user is not allowed to see it.

This also applies if the EXPLORER is not yet registered on the BGAN network, but the 
GPS position is received.
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The counters show totals for connections since the counters were last cleared. For information on 
how to clear the counters, see Log handling on page 105. 

Note If power to the terminal is interrupted (not a normal power down), the totals may not be 
updated correctly at next startup.
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Using the phone book

General usage

Overview

In the phone book you can:

• Look up phone numbers.

• Look up short-dial numbers for easy dialing from a handset. 

• Modify or delete existing names and phone numbers, or add new names and phone numbers.

Accessing the phone book

To access the phone book, select PHONE BOOK from the left navigation pane.
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The phone book shows all entries with entry number, name and phone number. Empty place 
holders are also included.

To sort the phone book, click the title of the column you wish to sort by. For example, to sort by the 
names in the phone book alphabetically, click on Name in the top row of the phone book.

The phone book holds 199 entries divided into subpages. To select the subpages you want, click 
the relevant link at the bottom of the page.

Short dial

The entry number in the phone book is the Short dial number. When making a call from the 
terminal you can use this number instead of dialing the entire phone number.

Simply dial 00 <short dial> followed by # or off-hook key.

Example: To call the third entry in the phone book from an analog phone, take the phone off hook 
and dial 003 #.

Editing phone book entries

Adding a new entry

To add a new entry, do as follows:

1. In the phone book, locate the empty entry number where you want to add the new phone 
number and click New.

2. Type in the name and phone number of the new entry and click Save entry.
The new name and number are now listed at the specified entry number in the phone book.

Modifying an entry in the phone book

To modify an entry, do as follows:

1. In the phone book, click Edit next to the entry you want to modify.

2. Modify the name or number as wanted and click Save entry.
The name and/or number in the selected entry is now replaced with the new information.

Deleting an entry in the phone book

To delete an entry, click Delete next to the entry you want to delete.

Deleting all entries in the phone book

To delete all the entries in the phone book, click Delete all entries in phone book at the bottom of 
the PHONE BOOK page.
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Viewing and editing the mobile numbers

To view the mobile numbers

To view the mobile numbers of the terminal, select PHONE BOOK > Mobile numbers from the left 
navigation pane. The mobile numbers are the phone numbers to use when making a call to the 
terminal.

To enter or edit the mobile numbers

To enter or edit the mobile numbers, click Edit at the bottom of the page, type in the numbers 
received from your Airtime Provider and click OK.

Note These numbers are not listed at delivery. The user must enter the numbers received from 
the Airtime Provider.
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Using the Call log

Information on total usage

To enter the CALLS page select CALLS from the left navigation pane. The CALLS page contains 
information on usage for circuit switched connections.

For an explanation of the circuit switched services, see Circuit switched (dialed) service on page 10.

The listed information includes:

• time connected using Standard Voice and 

• time connected using 3.1 kHz Audio.

Note If power to the system is interrupted, the information on the currently ongoing calls 
(connection time) and data sessions (transferred data) cannot be saved. This could mean 
that the airtime and bandwidth usage in the Call log will be inaccurate and there is a risk 
of being charged for more airtime than registered in the web interface. 
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Exporting the call log

You can export the call log file for archiving, surveillance or other tracking purposes. 

The call log holds information on all calls and data sessions since the call log was last cleared. For 
information on how to view the lists of calls and data sessions, see the next section.

To export the entire call log to a file, do as follows:

1. In the CALLS page, click the link Export call log to file.

2. Browse to the location where you want to save the log.

3. Click OK.

Viewing the lists of calls

To see information on outgoing, received or missed calls or data sessions, select one of the 
following lists from the left navigation pane in the CALLS page:

• Outgoing calls shows the start time, receiving end phone number, duration, type (Standard or 
3.1 kHz Audio) and estimated charge of each outgoing call. 

• Received calls shows the start time, calling phone number, duration and type (Standard or 
3.1 kHz Audio) of each incoming call.

• Missed calls shows the start time, calling phone number and type (Standard or 3.1 kHz Audio) 
of each incoming call that was not received.

• Standard data sessions shows the start time, bytes in, bytes out and estimated charge of each 
Standard IP session.

• Streaming data sessions shows the start time, duration, type (Streaming 32, 64, 128 or 
256 kbps) and estimated charge of each Streaming IP session.

Date and time is the international UTC time, received from the satellite. 

For information on the available types of service, see The BGAN services on page 10.

You can sort each of the lists by clicking the title of the column you wish to sort by. 

If a list covers more than one page, you can click the relevant link at the bottom of the page, to go 
to another page.

When there are more than 100 calls in the total list, the oldest calls are automatically removed to 
make room for new calls.

Note The estimated charge is based on your entries under ADMINISTRATION > Call charges. 
Thrane & Thrane does not take responsibility for the correctness of this estimated charge.
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Handling SMS messages

Sending an SMS message

To send an SMS message from the terminal, do as follows:

1. Click MESSAGES from the left navigation pane.
This page contains new incoming messages.

2. In the left navigation pane, click Write message.

3. Type in the message in the Write new message field.
If the message text is too long for one SMS, the message is sent as two or more SMS 
messages. The field below the message field shows the number of SMS messages used to 
send the message.

4. Type in the phone number in the Recipient field. 
Remember 00 and country code (e.g. 00 45 to call Denmark or 00 1 to call USA).

Important If the terminal is not online when you attempt to send a message, the message is 
moved to the Outbox in stead of the Sent folder. Messages in the Outbox are not 
automatically sent when the terminal goes online. For further information on the 
Outbox, see the next section, Options for messages in the Outbox.

To make sure a message has been sent, check that it has been moved to the Sent 
folder.
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5. Select whether or not you want Delivery notification for this SMS message. 
If you click Yes, the Status column in the Sent folder will show the status of your message 
when it has been sent.
You can set up delivery notification generally for all SMS messages. This setting is used by 
default when you send a message. For further information, see Configuring message settings 
on page 60.

6. Click Send.
The message is now sent and moved to the Sent folder. 

Options for messages in the Outbox

Messages in the Outbox are messages that have not been sent, e.g. because the terminal was not 
online when you attempted to send the messages.

To access the Outbox, click MESSAGES > Outbox from the navigation pane.

You have the following options for messages in the Outbox:

• When the terminal is online, click Resend next to the message you want to send. When the 
Write message page opens, click Send.
The terminal now attempts to send the message again. To make sure the message has been 
sent, look in the Sent folder.

• Click Delete next to a message to delete it.

• Click Delete all messages in Outbox to delete all the messages.

Options for messages in the Sent folder

The Sent folder contains SMS messages that have been sent.

To access the Sent folder, select MESSAGES > Sent from the navigation pane. 

The Status column shows the status of each message, if you have selected Delivery notification 
when sending the message.

From the Sent folder you have the following options:

• Click Resend next to a message you want to send again. 
When the Write message page opens, click Send.
The terminal now attempts to send the message again. To make sure the message has been 
sent, look in the Sent folder. There should now be two copies of the sent message.

• Click Forward next to a message you want to forward. 
Type in the phone number of the new recipient and click Send.
The terminal now attempts to send the message to the new recipient. To make sure the 
message has been sent, look in the Sent folder.

• Click Delete next to a message to delete it.

• Click Delete all sent messages to delete all the messages.

Note The original message remains in the Outbox. When you have succeeded in sending 
the message you may want to delete it from the Outbox.
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Sending an SMS message to the terminal

You can send an SMS message to the terminal e.g. from a mobile phone, using one of the mobile 
numbers for voice. Dial

+ <Mobile number>

The first part of the mobile number is always 870, which is the “country code” for the BGAN system. 
If the mobile numbers are listed in the web interface, you can look them up as follows: 

Select PHONE BOOK > Mobile numbers. If the mobile numbers are not listed in the web interface, 
refer to your airtime subscription.

Receiving a message

If a message has arrived, the icon bar at the top of the web interface shows an unopened 
envelope. Click the envelope to see the new message(s).

Otherwise, to see new messages click MESSAGES from the left navigation pane. 

The page shows new incoming messages.

If the message is not an SMS message but information of voice mail, call your voice mail service 
number to hear the voice mail.
To find your voice mail number, select MESSAGES > Message settings from the left navigation 
pane and locate the Voice mail number. 

Note that the voice mail number is only shown if it is available on the SIM card. Otherwise, refer to 
the information included with your Airtime subscription.

Note There are two Voice numbers, one for 3.1 kHz Audio and one for Standard Voice.

Note The terminal does not accept more than 100 incoming messages (including read and 
unread messages). If you have received 100 messages, you have to delete some of them 
in order to free space for new messages. Otherwise, the new messages are rejected.
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Options for new SMS messages

To see new messages, click MESSAGES from the left navigation pane. 

Besides viewing the new messages, you have a number of options for what to do with each 
message:

• Click Read to move it to your Inbox containing read messages.

• Click Reply to reply to a message. 
Then type in your reply and click Send.
For information on how to include the original message in your reply, see Setting up the 
default message options on page 60.

• Click Forward to forward a message to someone. 
Then type in the phone number in the Recipient field and click Send.

• If you want to move all the new messages, click Move all new messages to Inbox.

Options for SMS messages in the Inbox

The messages in the Inbox are the incoming messages that have been read and moved from the 
list of new messages (refer to the previous section).

From the Inbox, you have the following options:

• Click Reply to reply to a message. 
Then type in your reply and click Send.
For information on how to include the original message in your reply, see Setting up the 
default message options on page 60.

• Click Forward to forward a message to someone. 
Then type in the phone number in the Recipient field and click Send.

• Click Delete to delete the message. 

• Click Delete all messages in Inbox to delete all read messages in the Inbox. 

Note New messages cannot be deleted until they have been moved to the Inbox.
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Configuring message settings

Setting up the default message options

You can set up general options for your outgoing messages. These settings apply by default to all 
your outgoing messages. Note, however, that you can change the Delivery notification setting for 
an individual message. For further information, see Sending an SMS message on page 56.

Do as follows:

1. Select MESSAGES > Message settings from the left navigation pane.

2. If you want to include the original message when you reply, select Yes next to Include message 
in reply.

3. Select whether or not you want Delivery notification for SMS messages. 
If you click Yes, the Status column in the Sent folder will show the status of your message 
when it has been sent.

4. Click Apply.
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Viewing or changing SMS service center number

The SMS service center number identifies the SMS service center used when sending and 
receiving SMS messages. The SMS service center number is stored on the SIM card.

• To see the SMS service center number, select 
MESSAGES > Message settings from the left navigation pane.

• To change the number, click Edit next to SMS service center, change the number and click 
Save. Then click Apply to apply all changes in the page.

The SMS service center number is provided from your Airtime Provider.

Viewing the Voice mail number

The Voice mail number is the number you call to hear your incoming voice mail.

To see the Voice mail number, select
MESSAGES > Message settings from the left navigation pane. The Voice mail number field shows 
the Voice mail number.

Note The Voice mail number is only listed if it is available on the SIM card. Otherwise, refer to 
the information included with your Airtime subscription.
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Setting up the interfaces

The SETTINGS page (Antenna properties)

The SETTINGS page shows properties of the connected antenna and contains a field for enabling 
or disabling the L-Band interface on the terminal.

To access the SETTINGS page, select SETTINGS from the left navigation pane.

Enabling or disabling the L-Band interface (future use)

To enable or disable the L-Band interface, do as follows:

1. In the L-BAND CONNECTOR field of the SETTINGS page, select Enable or Disable.

2. Click Apply.
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Configuring the LAN interface

Overview

The EXPLORER 727 terminal has 4 LAN connectors with PoE (Power over Ethernet). 

The major part of the LAN parameters are set up in the network management pages, which require 
administrator password. For information on these settings, refer to Managing LAN network users 
on page 82.

Setting up the local LAN IP addressing

In the web interface you can set up the IP addressing between the terminal and devices connected 
to the terminal. The terminal has a built-in DHCP server which can be used to dynamically assign 
IP addresses to devices connected to the terminal.

You can also set up the local IP address used by the connected devices to access the terminal. The 
drawing below shows the default setup.

CAUTION! All connections to the LAN interface may be affected when you change 
the following settings. This also includes your own current connection to the web 
interface.

Local IP addresses
(default setup)

Terminal

Device 1

Device 2

192.168.0.1

192.168.0.1

assigned by the  
terminal (DHCP)

assigned by the  
terminal (DHCP)
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To change the local IP addressing, do as follows:

1. From the left navigation pane, select SETTINGS > LAN.

2.  At DHCP status, select Enabled (recommended for most purposes), or Disabled.

• If you select Enabled, the terminal assigns dynamic IP addresses to devices connected to the 
terminal. 

• If you select Disabled, you need to set up a static IP address in the connected device.

3. If you want to change the Local IP address and the Netmask, type in the new address and 
netmask.
The Local IP address is the IP address of the terminal. It is used for accessing the web 
interface. By default, the address is 192.168.0.1 and the netmask is 255.255.255.0.

4. Click Apply.
98-126882-C Setting up the interfaces 64



Chapter 4: Using the web interface
Port forwarding

Port forwarding enables you to set up a server connected to the terminal while the terminal is in 
Router mode. Without port forwarding it would not be possible to contact the server from the 
Internet.

For information on how to set the terminal in Router mode, see Setting up the network user groups 
on page 84.

The following example shows how to allow Internet access to a mail server (smtp) connected to the 
terminal. 

The mail server in this example has the IP address 192.168.0.100.

1. Select LAN > Port forwarding in the left navigation pane.

2. Select Enabled to generally enable port forwarding.

3. Type in the Incoming port range.

4. Type in the Destination IP address, which in this example is the IP address of the mail server: 
192.168.0.100.

5. Type in the Destination port range. 

6. Repeat step 3. to step 5. to set up port forwarding to additional servers.

7. In the Active column, select which ports should have port forwarding activated.

8. Click Apply.

You can now access the mail server from the Internet, using the external IP address of the 
terminal.
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Configuring the Phone/Fax interface

Do as follows:

1. Select SETTINGS > Phone/Fax from the left navigation pane.

2. For each Phone/Fax port, set the call type for incoming and outgoing calls.

The call types are described in more detail in Selecting the call type on page 28.

• For Incoming calls, you can select Standard or 3.1 kHz Audio or both. 
If you select both, any device connected to the Phone/Fax interface will react (ring) on 
incoming calls. 
If you select e.g. Standard, the Phone/Fax interface will only react on calls made to the 
Standard phone number.

• For Outgoing calls, you can select either Standard or 3.1 kHz Audio. The selected type will be 
used by default, if possible, for any outgoing call. Note, however, that fax machines and 
modems must use 3.1 kHz Audio.

3. Click Apply.

Note Port 1 is the connector closest to the antenna connector, and Port 2 is the connector 
closest to the ISDN connector.

Note You can override the default setting for outgoing calls by dialing 1* (force the call to 
Standard) or 2* (force the call to 3.1 kHz Audio) before the number. For further 
information, see Overriding the default outgoing call type on page 28.
98-126882-C Setting up the interfaces 66



Chapter 4: Using the web interface
Configuring the ISDN interface

To configure the ISDN interface, do as follows:

1. Select SETTINGS > ISDN.

2. Set the call type(s) for incoming calls.
You can select Standard, 3.1 kHz Audio, UDI and/or RDI. 

3. Set the MSN numbers that are to be assigned to each call type. 
Note that this setting only applies to the call type selected above the MSN number, and only if 
the connected device supports the call type used.

 

Note For information on how to set up call services (supplementary services), see Setting up 
call services on page 71. These settings apply to both the Phone/Fax interface, the ISDN 
interface and the LAN w. PoE interface.

Note Connected devices will only receive incoming calls with the call types that are 
selected here. 
For example, if only Standard is selected, and a G4 fax call (using call type UDI) 
arrives, a fax connected to the ISDN port will not receive the incoming call. 

Important If you set an MSN number to anything other than <None>, connected devices 
must be programmed with these MSN numbers.
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You have the following options with the MSN numbers:

• <None>. No MSN numbers are used. An incoming call is accepted in all devices connected to 
this port.

• 1*, 2*, 3* or 4*: If, for example, you select 1* at Standard call type, an incoming Standard 
call is accepted by all devices that are programmed with the number 1* and connected to the 
ISDN interface.

• 0401, 0402: These are local numbers for separate devices connected to the ISDN interface.
An incoming call is accepted by devices that are programmed with the selected number and 
connected to the ISDN interface. 

You can combine the MSN settings.

Example: You have two devices connected to the ISDN interface. One is programmed with 
the numbers 1* and 0401, the other is programmed with 1* and 0402. 
In the web interface, you select the MSN number 1* under Standard.
If an incoming Standard call arrives, both devices will accept the call. 
If you make a local call to one of the local numbers 0401 or 0402, only the called 
device will accept the call.

4. Set the call type for outgoing calls.

• If you select Automatic, the call type will be determined by the calling device.

• If you select Standard, all outgoing calls, except UDI/RDI, will use the call type Standard. If 
you make a 3.1 kHz Audio call it will be converted to a Standard call.
Outgoing UDI or RDI sessions will be not be influenced by this setting.

• If you select 3.1 kHz Audio, all outgoing calls, except UDI/RDI, will use the call type 3.1 kHz 
Audio. If you make a Standard call it will be converted to a 3.1 kHz Audio call. Outgoing UDI 
or RDI sessions will be not be influenced by this setting.

5. Click Apply.

Note You can override the call type setting for outgoing calls by dialing one of the 
following prefixes before the number:

• 1* (force the call to Standard)

• 2* (force the call to 3.1 kHz Audio)

Refer to Overriding the default outgoing call type on page 28.
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Setting the common interface settings

Overview

The settings under COMMON are common for all interfaces. Note, however, that in order to use the 
common Access Point Name for an interface, you must select Common for the APN setting when 
setting up the network user group.

Definition of Access Point Name (APN)

The APN is used by the network user to establish a connection to the required external network. 
This means that the terminal must know the APN in order to be able to connect to the external 
network. 
APNs are provided from the Airtime Provider. They may also be defined on the SIM card.

The common APN

The common APN setting is defined here and can be selected for each network user group. If you 
are using the same APN for many network user groups, it is easier to define it once, and then 
simply select it for the relevant network user groups. Also, if you change the common APN at a 
later stage, it is automatically updated for all network user groups where the Common setting is 
selected.
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To set up the common interface settings

Do as follows:

1. Select SETTINGS > Common.

2. Select the APN. You have the following options:

• SIM default. The APN is taken from the SIM card. This is the recommended option, unless 
you have special requirements.

• Network assigned. The APN is assigned from the network.

• User defined. Type in the APN. APNs are provided from the Airtime Provider.

3. At Buffering on Streaming profiles, select Enabled or Disabled.

• If you select Enabled, your Streaming connection will be buffered. This means that the 
transmission is slightly delayed in order to ensure a precise and continuous data stream.

• If you select Disabled, your Streaming connection will not be buffered. This means the data 
is delivered immediately, but may vary slightly in transmission speed.

4. Click Apply.
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How to use the common APN

When you configure the APN for your individual network user group, select Common to use the 
setting from this page. 

Where Common is selected in the individual network user groups, the setting will automatically be 
updated when the Common APN is changed.

Setting up call services

Overview

The setup of call services is also common for all interfaces.

In the web interface you can set up the following supplementary services:

• Call forwarding

• Call barring

• Call waiting

• Line identification

• Closed user group

Note that, depending on the network, some of these call service settings may prevent others from 
being activated.

The settings apply for all connected devices using a circuit-switched service.

Note The terminal must be registered on the BGAN network before you can set up the call 
services in the web interface.
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Call forwarding

You can set up the terminal to automatically forward incoming calls to another phone number. Do 
as follows:

1. Select SETTINGS > Common > Call forward from the left navigation pane.

2. For each call type, select Enabled next to the situation(s) in which you want to forward 
incoming calls.

3. Next to the enabled items, type in the phone number you want to forward the call to.

4. If you have selected Forward if no reply, select from the drop-down list the period of time the 
system should wait before forwarding the call.

5. Click Apply.
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Call barring

Do as follows to bar incoming and/or outgoing calls to and from the terminal:

1. Select SETTINGS > Common > Call barring from the left navigation pane.

2. Click OK next to Read current settings, to make sure the page is updated.

3. For each call type, select which calls should be barred.

4. In the Barring PIN field, type in a PIN for your call barring setup.

5. Click Apply.

Note This is not the SIM PIN entered at startup, but a network PIN which is supplied 
together with your SIM PIN. 
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Call waiting

You can set up whether or not you want to receive notification of waiting calls while you are 
making a call or transmitting data.

Do as follows:

1. Select SETTINGS > Common > Call waiting from the left navigation pane.

2. Click OK next to Read current settings to make sure the page is updated.

3. For each call type, select Call waiting enabled if you want to get notification of waiting calls 
while you are making a call or transmitting data.

4. Click Apply.
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Line identification

You can set up the terminal to show your number when you are making a call or transmitting data.

Do as follows:

1. Select SETTINGS > Common > Line identification from the left navigation pane.

2. Select Show my number and click Apply.
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Closed user group

Your subscription may include one or more closed user groups. A closed user group is a group of 
users permitted to make calls to each other but not to users outside the group.

To define the settings for these user groups, do as follows:

1. Select SETTINGS > Common > Closed user group from the left navigation pane.

2. Type in your user group number(s) under Group no.
Your airtime subscription lists your user group number(s).

3. Select which group(s) should be active.
If you select Subscribed, the group(s) included in your subscription will be active.

4. To allow outgoing access for the activated user group(s), select Outgoing Access under 
SETTINGS FOR ACTIVE CLOSED USER GROUP. Note that if you selected Subscribed above, this 
setting will not be used.

5. Select Preferential if you want the activated user group to be selected when a member of a 
user group does not specify the group number during call set up. Note that if you selected 
Subscribed above, this setting will not be used.

6. Click Apply.
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Managing IP handsets

Overview

The terminal has 4 LAN (PoE) connectors for connection of IP handsets or other IP equipment. You 
may connect your IP handsets directly to the LAN interfaces or use a PoE switch to connect more 
handsets. The EXPLORER terminal supports connection of up to 16 handsets.

Each handset must have a local number in the range 0501 to 0516 as well as a unique password. 
Note that you must set this up in the web interface for the connections to work. For further 
information, see the next section Connecting a new IP handset.

Connecting a new IP handset

To connect a new IP handset, do as follows:

1. Connect the IP handset to one of the LAN ports of the terminal.

2. In the web interface, select SETTINGS > IP handsets.

Note The handset with the local number 0501 is the master handset. This means you can 
start/stop data sessions from the terminal with this handset, if the function is allowed in 
the User permissions page. See Setting up user permissions on page 112.

Note The first handset that is connected to the LAN interface on the terminal is automatically 
registered in the terminal and assigned the local number 0501 and password 0501.
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3. Next to the local number you wish to use, click New.

4. Enter the password you want for your IP handset.
Note that the Thrane IP handset only supports numbers (no letters) in the password.

5. In the IP handset, use the display menu system to enter the local number and the password 
you just entered in the web interface. Do as follows:
1. Enter the menu system and select SIP to get the list of profiles.
2. Select the BGAN profile and select Options.
3. Select Edit/View and change the user name and password. 
Note that the user name is also the local number for the handset.

When the terminal and the handset have recognized each other, a Configure link appears next to 
the handset in the IP handsets page of the web interface. This link provides direct access to the 
built-in web interface of the IP handset. For further information, refer to the user manual for the IP 
handset.

Setting up the IP handsets

To set up IP handsets, do as follows:

1. Select SETTINGS > IP handsets.

2. Select Edit next to a handset to change the password of the handset.
Remember that you must enter the same password and local number (user name) in the IP 
handset.

3. Select Delete next to a handset to delete it from the list.
When a handset is deleted from the list, you can no longer access the terminal with this 
handset.
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4. Select Configure next to a handset to access the built-in web interface of the IP handset. 
The web interface of the IP handset opens. It is very similar to the web interface of the 
terminal, but has a handset icon in the top left corner.
With the web interface of the IP handset you can access the internal settings of the IP 
handset. For further information, refer to the user manual for the IP handset.

Setting the call types for IP handsets

To set the call types for IP handsets, do as follows:

1. Select SETTINGS > IP handsets > Call settings.

2. For each handset, select the call types you want to enable for incoming and outgoing calls.
The call types are described in more detail in Selecting the call type on page 28.

• For Incoming calls, you can select Standard or 3.1 kHz Audio or both. 
If you select both, the handset will react (ring) on any incoming call. 
If, for example, you select Standard, the handset will only react on calls made to the 
Standard phone number.

• For Outgoing calls, you can select either Standard or 3.1 kHz Audio. The selected type will be 
used by default, if possible, for any outgoing call.

3. Click Apply.
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Configuring the discrete I/O interface

I/O pins and their functions

The I/O interface on the terminal has 5 configurable I/O pins. You can set up the function of each 
pin in the web interface. The default functions of the I/O pins are as follows:

• Pin 1: Ringer output.
(Default setting: Normally open)
Pin 1 acts as a built-in switch in the terminal. By default, this pin is internally connected to 
Ground when the terminal is notified of an incoming call from the satellite interface. When the 
call is answered, or the caller gives up and releases the call, the pin is disconnected (open).

• Pin 2: Warning/Error output.
(Default setting: Normally open)
Pin 2 acts as a built-in switch in the terminal. By default, this pin is internally connected to 
Ground when there is an active warning/error condition in the terminal. The pin stays 
connected to ground until all warnings/errors are cleared.

• Pin 3: Mute output.
(Default setting: Normally open)
Pin 3 acts as a built-in switch in the terminal. By default, this pin is internally connected to 
Ground as long as there is a phone call in progress. This signal can be used to mute external 
equipment.
When the call is released, the pin is disconnected (open).

• Pin 4: Radio silence input.
(Default setting: Active Low)
By default, pin 4 is activated when externally connected to Ground. When pin 4 is activated, 
the terminal observes Radio Silence. The terminal gracefully closes all open connections, and 
deregisters from the BGAN network. No transmission is allowed until the pin is deactivated 
(disconnected from Ground).

• Pin 5/8: Ignition input.
(Default setting: Active high)
The ignition function can be used to turn on/off the terminal by means of an external signal. 
The ignition function uses pin 5 together with pin 8 (DC in). Connect the appropriate pin to the 
ignition key switch as follows:
Active high (default): Connect pin 5 to Ground. Connect pin 8 to “high” (10.5-32 V DC) when 
the ignition is on.
Active low: Connect pin 8 to positive DC voltage (10.5-32 V DC). Connect pin 5 to Ground (< 1.2 
V DC) when the ignition is on.

• Pin 6: Ground.
(Non-configurable)
Pin 6 can be used as an external connection to ground. Pin 6 is connected to Ground in the 
terminal.

• Pin 7: DC output.
(Non-configurable)
Pin 7 can be used as a DC output. The Voltage on pin 7 is 9-15V and can supply up to 50mA. 
Pin 7 can be used as power supply to a relay, ringer or similar.
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Configuring the I/O interface

To configure the I/O pins, do as follows:

1. Select SETTINGS > Discrete I/O.

2. For each pin you want to use, select Enabled.

3. For each pin, select the function of the pin. Refer to the previous section, I/O pins and their 
functions on page 80.

4. If you are using the Ignition function and you want the terminal to stay on for a few minutes 
after the Ignition is switched off, enter the number of minutes under DELAYED SHUTDOWN.
For further information on the Ignition function, see Using the ignition system on page 16.

5. If you are using a ringer output, select the incoming call types that should activate the ringer 
under RINGER OUTPUT.

6. If you are using a Mute output, select the incoming call types that should activate the Mute 
function under MUTE OUTPUT.

7. Click Apply.
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Managing LAN network users

Introduction

Network user groups

The network management system divides the users of the EXPLORER 727 terminal into network 
user groups. Each network user group has a profile which determines how the users connect to 
the Inmarsat BGAN network. The network user groups can allow or restrict certain services for 
different users.

The EXPLORER 727 terminal supports up to 11 different network user groups and global IP 
addresses.

The network user group you belong to is determined by one or more of the following:

• the LAN port you connect to

• the IP address of the device you are using

• the MAC address of the device you are using

Necessary steps when managing network users

The steps necessary for managing network users include:

1. Defining a network user group. See Setting up the network user groups on page 84.
The network user groups determine settings such as:

• QoS (Standard/Streaming),

• IP addressing (Static/Dynamic)

• Internet access mode (Router Mode/Bridge Mode/No Internet Access)

2. Identifying a network device. See Managing network devices on page 88.
The network devices are identified by their IP address, MAC address and (optionally) device 
name.

3. Associating the network user group and the network device. See Using the network 
classification table on page 90.
The network classification table determines which devices should belong to which network 
user group. When a network device is connected, the terminal runs through the network 
classification table to check if the new connection matches any of the entries in the table. 
When a match is found, the terminal establishes a packet data connection (PDP context) with 
the settings defined in the belonging network user group, and the device is ready for use with 
the terminal.
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Access to the network management settings

Access to the network management settings requires an administrator password.

The administrator can create and manage network user groups and set up a network classification 
table defining priorities for devices, network user groups and LAN ports.

 

CAUTION! All user connections to the LAN interface may be affected when you 
change the settings below, including your own current connection to the web 
interface!
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Setting up the network user groups

Overview

A network user group, in this context, is a group of network users sharing the same Quality of 
Service profile and network parameters.

There are 11 configurable network user groups. For the Default network user group certain settings 
are locked to make sure there is always one functional network user group available. For example, 
the Default network user group does not allow you to select a Bridge mode connection.

Editing a network user group

To edit a network user group, do as follows:

1. Select SETTINGS > LAN > Network user groups.
When you are prompted, enter the administrator user name and password. The default user 
name is admin and the default password is 1234.

Note The network user groups cannot be deleted. If you do not want to use them, click Edit 
and select Disabled at Status in the NETWORK USER GROUP field.

Note For further explanation of the terms used below, see Definitions for network terms 
on page 93.
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2. Click Edit next to the network user group you want to set up.

3. Type in a name for the group.

4. Select Enabled or Disabled.

5. Select the type of Internet connection.

• Router mode means the connection will be shared with other users, and the NAT module of 
the terminal will make the necessary address translations. Use this mode if one or more 
computers are connected using the LAN interface, and the terminal should act as a router. 

• Bridge mode is an exclusive connection, with NAT disabled. Use this mode together with a 
network classification entry that selects a single computer (see Using the network 
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classification table on page 90). This mode is not available in the Default network user 
group.

• No Internet access means no connection to the Internet is allowed. Use this setting e.g. for 
IP handsets, where an Internet connection is not required. The external voice connection is 
still available; this setting only affects communication over the Internet.

6. Select Dynamic IP address. 
This is the IP address used externally on the satellite network.
If you want to use a static IP address, and your subscription allows it, you must still leave this 
setting at Dynamic. Then select SIM default in step 8. and type in the APN user name and 
password from your provider in step 9..
Your terminal will then use the static IP address set up for your SIM card.

7. Set IP Header compression to Enabled or Disabled. 
For information on IP Header compression, see Header compression on page 93.

8. Select the source of the APN (Access Point Name).
There are four options for setting the APN. Unless you have special requirements, it is 
recommended to use the SIM default, or to set the common APN to SIM default, and then 
select Common here. You have the following options:

• Common. The APN is taken from the Common APN defined under 
SETTINGS > Common. Refer to Setting the common interface settings on page 69.

• SIM default. The APN is taken from the SIM card. If you want to use a static IP address on 
the external network, select this option either here or in the Common setting.

• Network assigned. The APN is assigned from the network.

• User defined. Type in the APN. APNs are provided from the Airtime Provider.

9. If your APN uses a password, type in the user name and password provided from the Airtime 
Provider. 

10.  At Automatic activation select whether the profile selected in the next step should be 
activated automatically or manually.

• Disabled means you can activate/deactivate the profile from the Dashboard.

• Enabled means the profile is activated automatically.

11. Select the Primary profile.
Select a profile from the Primary scroll list. This profile is used by this network user group as a 
first choice, when possible.

Note Typing in a static IP address is currently not supported by the BGAN network.

Note If you are going to use the static IP address from your SIM card, the user name and 
password are mandatory! See step 6. above.

Note If the selected primary profile is a Streaming profile, this setting has no effect. 
Streaming profiles must always be activated manually from the Dashboard.
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There are 5 predefined profiles: Standard, Streaming 32 kbps, Streaming 64 kbps, Streaming 
128 kbps and Streaming 256 kbps. Additionally, you can define your own custom profiles.

For further information on profiles and traffic flow filters, see Using profiles on page 106 and 
Using traffic flow filters on page 109.

12. Select the Secondary profile.
To select more than one secondary profile, press and hold Ctrl or Shift while selecting.

The Context Identifiers (CIDs) for the selected primary and secondary profiles are listed under 
Profile CIDs.

13. Click Apply.

Important If you have selected a Streaming connection as your primary profile, the LAN 
interface will be running a Streaming connection until you stop it or disconnect 
the interface. However, if you select one or more secondary profiles, you can set 
up your traffic flow filter so that it will only use the Streaming profile for certain 
types of traffic.

Note If you have selected both a primary and one or more secondary profiles you must 
define a traffic flow filter before you can establish a valid connection.
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Managing network devices

Overview

A network device, in this context, is an Ethernet hardware device, identified by its unique MAC 
address.

When a network device with dynamic IP address is connected to the terminal, it is automatically 
listed in the Network devices list.

Viewing the list of network devices

To view the list of network devices, select SETTINGS > LAN > Network devices.

If you are prompted, enter the administrator user name and password. The default user name is 
admin and the default password is 1234.

All network devices that have been connected to the terminal are listed here.
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Locking an IP address to a MAC address

When the device is locked to an IP address, the terminal will always assign this IP address to the 
MAC address of this device (if DHCP is enabled and the Internet connection is not a Bridge mode 
connection).

To lock a device to its current IP address, click the link next to the device. 
The device is then locked to the current IP address and added to the list of locked IP addresses at 
the top of the page.

To unlock a device from the IP address, click Delete next to the device in the LOCKED IP 
ADDRESSES list.
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Using the network classification table

Overview

The network classification table is used to define which network devices, IP addresses and/or LAN 
ports are associated with which network user groups.

Each entry in the table shows MAC address, IP address, LAN port and network user group.

When a network device is connected, the terminal runs through the network classification table to 
check if the new connection matches MAC address, IP address and LAN port in any of the entries 
in the table. When a match is found, the terminal establishes a PDP context with the settings of the 
network user group assigned in the matching entry. The device is now ready for use with the 
terminal.

Adding or editing an entry in the network classification table

To add a new entry to the table or to edit an existing entry, do as follows:

1. Select SETTINGS > LAN > Network classification table.
If you are prompted, enter the administrator user name and password. The default user name 
is admin and the default password is 1234.

The network classification table shows which devices are associated with which LAN ports and 
network user groups. An Asterisk (*) is a “wild card”, meaning that any value is accepted.
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2. Click Edit next to the entry you want to edit, or click Add at the bottom of the list.

3. Click Add next to a network device you want to use, or type in the MAC address manually at the 
top of the page.

4. Select the LAN port and Network user group you want to associate with the device.
Network user groups are created and defined in the Network user group page. See Setting up 
the network user groups on page 84.

5. Click Apply.

Removing an entry in the network classification table

In the network classification table, click Delete next to the entry you want to delete.

Note If you leave a field empty, it is the same as a “wild card” and it will be shown as an 
Asterisk in the network classification table.

Unless you are using a Static IP address, the IP address field should always be left 
empty.
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Changing the priority in the network classification table

To change the priority of an entry, click the up or down arrow next to the entry.

Connections are evaluated in the order they are listed. The first entry (and only the first entry) that 
matches the properties of the connected device is applied, meaning that the connection will be 
using the settings of the network user group assigned to that entry.

The Default network user group is always last, so it is only used if none of the other entries match 
the properties of the connected device.
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Definitions for network terms

APN (Access Point Name)

APNs are provided from the Airtime Provider. They may also be defined on the SIM card
The APN is used by the network user to establish a connection to the required external network. 
This means that the terminal must know the APN in order to be able to connect to the external 
network.

Header compression

The Header of a data packet contains control information belonging to that packet. The 
information in the Header can take up a considerable amount of bandwidth. In order to save 
bandwidth, you can use Header Compression, meaning you compress the header information, 
leaving some of the information out.

You can select whether or not to use Header Compression for your data transmission.

• Header Compression enabled: Recommended for low-noise applications.
If you select Header Compression enabled, you will be using less bandwidth on header 
information, leaving more bandwidth for the actual payload. 
However, if the environment is noisy, the system will have to retransmit information, and you 
may end up using more bandwidth than without Header Compression.

• Header Compression disabled: Recommended in noisy environments.
If Header Compression is disabled, the system will be less sensitive to noise.

Profiles

A profile is a collection of Quality of Service (QoS) settings and other settings defining the mode in 
which data is transmitted on an interface. For example, a profile is used to define whether a 
connection should be a Standard or Streaming connection.

You can select between a number of predefined profiles or define your own profiles for your data 
transmission.

You need an administrator password to define profiles and traffic flow filters.

NAT (Network Address Translation)

NAT enables a local-area network to use one set of private IP addresses for internal traffic and an 
assigned or static IP address for external traffic. The built-in NAT module in the terminal makes all 
necessary address translations between the local-area traffic and the external traffic.
If more than one user is connected, you must select a network user group with Router mode to use 
the NAT of the terminal. 

Note If you have selected more than one profile (one primary and one or more secondary 
profiles) for an interface, you must define a traffic flow filter before you can establish a 
valid connection.
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Starting/stopping data sessions

The administrator can start and stop data sessions for all network user groups connected to the 
terminal.

To start or stop a data session, do as follows:

1. Select CONNECT.
When you are prompted, enter the administrator user name and password. The default user 
name is admin and the default password is 1234.

2. Click on the session you want to start or stop.
Under ONGOING DATA SESSIONS at the top you can see which data sessions are currently 
active.
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Uploading software

Introduction

You can upload software from your computer to the terminal without entering the PIN. However, if 
your SIM card requires a PIN and the PIN is not entered, you must enter the Administration user 
name and password.

The web interface also offers the possibility of downloading the latest software version from the 
Internet to your computer.

The next pages describe how to upload software from your computer to the terminal and how to 
download software from the Internet to your computer.
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Uploading software from your computer

To upload software from your computer to the terminal, do as follows:

1. Download the new software as described in the next section, or acquire the software from 
Thrane & Thrane and save it on your computer.

2. Open the web interface and do one of the following:

• If the PIN has been accepted (or a PIN is not required), select SETTINGS > Upload from the 
left navigation pane.

• If a PIN is required and the PIN has not been entered, select ADMINISTRATION, enter the 
Administration PIN and password and click Logon. 
The default user name is admin and the default password is 1234. 
Then select Upload from the left navigation pane.

The UPLOAD page opens.

3. In the field UPLOAD SOFTWARE TO TERMINAL, click Browse...

4. Browse to the new software version and accept it.

5. Click the Upload button.
Note that the upload procedure takes a couple of minutes.

Note When upload is done, your terminal automatically restarts with the new software.
98-126882-C Uploading software 96



Chapter 4: Using the web interface
Downloading software from the Internet

To download the latest software from the Internet to the terminal, do as follows:

1. Make sure you have a connection to the Internet from your terminal.

2. Open the web interface and select SETTINGS > Upload from the left navigation pane.

3. Click Check for updates.
The terminal will now connect to the Internet through the BGAN network, using your airtime 
subscription. It may take a minute or two to obtain the new software version.
When the new software version is found, the web interface shows the new software version 
and a link for downloading the software.

4. Click the link to download the new software to your computer.
After saving the software, follow the procedure in the previous section (Uploading software 
from your computer) to upload the software from the computer to your terminal.

Important The terminal uses your BGAN airtime subscription to download the new software 
from the Internet. Note that it can take several minutes to download the software.
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Selecting the preferred BGAN satellite

Overview

By default the terminal is set up to automatically find the most appropriate satellite to connect to 
(“Auto” mode). However, if you are located in an area with more than one BGAN satellite 
available, you can select the satellite you prefer to use when registering on the BGAN network.

To select the preferred BGAN satellite

To select the preferred BGAN satellite, do as follows:

1. Select SETTINGS > Satellite selection from the left navigation pane.

2. Select the satellite you prefer to use.

If you select Auto (the default setting) the EXPLORER 727 system automatically uses the most 
appropriate satellite.

Note At this writing the satellites are in the process of being repositioned. When all three 
satellites are in place, the next software release for the terminal will reflect the new 
satellite regions.

Important If you have any ongoing calls or data sessions, they will be terminated when 
you click Apply!
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3. Click Apply.
The EXPLORER terminates all ongoing connections and deregisters from the current satellite 
before registering on the new satellite.

Selecting the language

The default language of the web interface is English. To change the language, do as follows:

1. Select SETTINGS > Language.

2. Select a language from the list.

3. CLick Apply.

Note If you have selected one of the satellites, your EXPLORER 727 system will only try to 
register on the selected satellite. This means that if the antenna is outside the coverage 
area for that satellite, the EXPLORER 727 system will not be able to register with the 
BGAN network.
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Administration

Accessing the administration settings

Logging on

The Administration settings require an Administration user name and password. To log on as 
administrator, do as follows:

1. Select ADMINISTRATION from the left navigation pane.

2. Enter the Administration user name and password. 
The default user name is admin and the default password is 1234.

If you have forgotten the administrator password, you can reset the password by clicking the 
link at the bottom of the page. For further information, see the next section Resetting the 
administrator password.

3. Click Logon.
The Administration page is now updated to let you change the user name and password, 
Save/load a configuration or log off Administration.
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Resetting the administrator password

If you have forgotten the administrator password, do as follows:

1. Contact your supplier for a reset code.
Please report the serial number and IMEI number of the terminal.
You can find the serial number and IMEI number in the Dashboard.

2. Click the link Forgot administrator password? at the bottom of the ADMINISTRATOR LOGON 
page (see the previous section).

3. Type in the reset code obtained from your supplier and click Reset.

4. Type in the user name admin and the default password 1234.

5. Click Logon.
For information on how to change the password, see the next section Changing the 
administrator password.
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Changing the administrator password

To change the administrator password, do as follows:

1. After entering the administrator user name and password in the ADMINISTRATION page, 
locate the section Change administrator logon.

2. Type in the existing user name.

3. Type in the new password and retype it on the next line.

4. Click Change.
At the next logon the new password is required.
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Saving a configuration to a file

If you need to reuse a configuration in another terminal of the same type, you can save your 
current configuration to a file, which can then be loaded into the other terminal.

To save your current configuration to a file, do as follows:

1. In the ADMINISTRATION page, under Configuration, click Save.

2. Accept the default destination file name or type in the destination file name and location.

3. Click OK.
The configuration is now saved to a file. This file is used to load the configuration into another 
terminal. See the next section.

Loading a configuration from a file

To load a configuration from a file, do as follows:

1. In the ADMINISTRATION page, under Configuration, click Load.

2. Click Browse... to browse to the file you want to import. Then click Open.

3. Click Load.
The new configuration is now loaded into your terminal.

Logging off administration

If you have not entered anything for 30 minutes under ADMINISTRATION, you are logged off 
automatically.

To log off manually, click Logoff under administrator logoff in the ADMINISTRATION page.
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Call charges

If you know the tariff for your subscribed services, you can enter these tariffs in the web interface 
and automatically calculate the charges for your calls and data sessions.

To enter the call tariffs, do as follows:

1. From the left navigation pane, select ADMINISTRATION > Call Charges.

2. Select the currency from the Currency drop-down list.

3. Enter the tariff for each of the services.

4. Click Apply.
The entered tariffs are used for estimating the charges for calls and data sessions. The 
estimated charge is listed for each call or data session in the call log. For further information, 
see Viewing the lists of calls on page 55.

Note Thrane & Thrane does not take responsibility for the correctness of the estimated 
charges. This calculation is only a rough estimate of the charge, based on the tariff 
entered by the user. Also, the Airtime Provider may have different methods of measuring 
the airtime used.
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Log handling

To clear the logs of the terminal and/or reset the counters for the time connected, do as follows:

1. From the left navigation pane in the ADMINISTRATION page, select Log Handling.

2. To clear the Call log, click OK next to Clear call log?. 

3. To clear the total counters, click OK next to Clear total counters?.
This will reset the Time connected counters on the Calls page.
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Using profiles

What is a profile?

A profile is a collection of Quality of Service (QoS) settings and other settings defining the mode in 
which data is transmitted. For example, a profile is used to define whether the connection is a 
Streaming connection or a Standard connection.

You can select between a number of predefined profiles or define your own profiles for your data 
transmission.

If no traffic flow filters are defined, the Primary profile for a network user group is used for all 
traffic from that network user group. See What are traffic flow filters? in the next section. 

For further information on profiles, refer to the 3GPP standard TS 23.107 “Quality of Service (QoS) 
concept and architecture”.

The profiles are used in the network user groups.

Selecting the profiles for a network user group

When you set up a network user group, you select the profiles to use for that network user group. 
You select a Primary profile and optionally one or more Secondary profiles.

For further information on how to select the profiles, see Managing LAN network users on 
page 82.
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Defining new profiles

When you define your profiles you can select Subscribed for many of the settings. If you select 
Subscribed, the value given in your Airtime subscription is automatically used.

To define a new profile, do as follows:

1. From the left navigation pane, select ADMINISTRATION > Profiles.

2. In one of the User defined columns, fill in the top field with the name you want for your 
profile.

3. In the Traffic class row of your new profile, select a class from the drop-down list.

You may select one of the following:

• Conversational is real-time two-way conversation. It is primarily used for voice over IP and 
video conferencing.

• Streaming is real-time one-way communication. It is primarily used for video and audio.

• Interactive is two-way communication (not real-time). It is used for communication that is 
not very delay-sensitive, such as web browsing, data base retrieval and server access. 
Examples of machines interaction with remote equipment are: polling for measurement 
records and automatic data base enquiries (tele-machines).

Important For best performance, choose the right traffic class for your application. In 
general, Standard data (Background) is best suited for TCP/IP applications, and 
Streaming data is best suited for UDP traffic, e.g. live video or audio.
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• Background is used for data which is not delay-sensitive, such as E-mail, SMS, download of 
databases and reception of measurement records.

4. Type in the bit rates in kbps in the following rows:

• Maximum bit rate ul (kbps) is the maximum upload bit rate allowed for this profile.

• Maximum bit rate dl (kbps) is the maximum download bit rate allowed for this profile.

• Guaranteed bit rate ul (kbps) is the guaranteed upload bit rate needed for this profile.

• Guaranteed bit rate dl (kbps) is the guaranteed download bit rate needed for this profile.

5. In the Delivery order row, select from the scroll list whether or not data should be delivered in 
the same order it was sent. Yes means the data packets are delivered in the same order they 
were sent.

6. In the Maximum SDU size (byte) row, type in the maximum allowed packet size in Bytes 
(rounded off to nearest 10). The maximum packet size possible is 1520.

7. In the Delivery of erroneous SDUs row, select one of the following from the list:

• Yes means packets are allowed to contain errors. This setting is suitable for delay-sensitive 
transmission, because the need for retransmission is limited. The SDU Error settings in step 
8. and step 9. will apply.

• No means packets are not allowed to contain errors, and the SDU Error setting in step 8. will 
not be applied. This setting is suitable where error-free transmission is important and 
delays are accepted.

• No detect means that errors will not be detected, and the SDU Error setting in step 8. will not 
be applied.

8. If you selected Yes in step 7., select from the SDU error ratio drop-down list the fraction of a 
packet allowed to be lost or erroneous.

9. Select from the Residual bit error ratio drop-down list the undetected bit error ratio of a 
packet. If no error detection is requested, Residual bit error ratio indicates the bit error ratio in 
the delivered packets.

10. In the Transfer delay (ms) row, type in the delay in ms. This is the delay from the time data is 
received in the terminal until it arrives at the receiving end.

• If the Transfer delay is 500 ms, error correction is disabled.

• If the Transfer delay is 4000 ms, error correction is applied.

11. In the Traffic handling priority row, select from the drop-down list which priority this 
connection should have.

12. Click Apply.
The new profile is now added, and can be selected from the lists of primary and secondary 
profiles when you set up your interfaces.

Note When you click Apply, the bit rate values you typed in may be rounded off because 
only certain values are allowed.
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Using traffic flow filters

Purpose of the traffic flow filters

The purpose of the traffic flow filters is to assign different priorities to different types of traffic in 
order to optimize performance.

Example: When you are browsing the Internet a Standard IP connection is normally sufficient. 
However, to have a video conference you may need a Streaming IP connection in order 
to obtain a direct connection without interruptions. Your traffic flow filters can define 
these priorities, so that your connection is automatically set to Streaming e.g. when you 
have a video conference.

What are traffic flow filters?

When more than one type of traffic is needed, you must use both a primary and one or more 
secondary profiles. For the BGAN core network and the terminal to classify packets received from 
the external network into the proper profile, you need a traffic flow filter.

A list of traffic flow filters consists of one to eight packet filters. Each packet filter has an evaluation 
precedence index that is unique within all traffic flow filters associated with the profiles that share 
the same PDP (Packet Data Protocol) address. The evaluation precedence index determines the 
order in which the filters are applied; 0 is applied first, then 1 and so forth. Information of source, 
destination, type of service etc. is combined in each packet filter in the list.
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Defining traffic flow filters

To define the traffic flow filters, do as follows:

1. From the left navigation pane, select 
ADMINISTRATION > Traffic flow filters.

2. Click the link New entry.

3. Select a number in the Eval.Prec. Index drop-down list.
The evaluation precedence index defines the order in which the traffic flow filters are applied 
to packets. 0 is first, then 1, 2 etc.

4. Select the Profile from the drop-down list.
The available profiles are the profiles listed under ADMINISTRATION > Profiles.
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5. Fill in one or more of the following fields to define the filter.
The allowed ranges appear in hover text when you pass the mouse over the fields.

• Source address + Subnet mask.
This is an IPv4 IP address and subnet mask.

• Protocol number.
This number is uniquely assigned for the protocol being used. TCP is set to 6, and UDP is set to 

17. The protocol number determines which protocol is used by the traffic flow filter.

• Destination port range (From and To). 

• Source port range (From and To). Note that you must fill in both From and To, even if there 
is only one port.

• Type of Service + Type of Service mask.
Set this value to a number between 0 and 255. 

Type of Service (TOS) is an 8-bit field in a packet header, with associated mask, that is used to 

define Quality of Service.

For further information on the principles and parameters of the traffic flow filters, refer to the 
3GPP standards TS27.007 V4.2.0 and TS 23.060 V4.7.0.

6. Click Apply at the bottom of the page.

Example of a list of traffic flow filters

Below is an example of a list of traffic flow filters.

In this example, data packets are filtered in the following order:

1. The filter with evaluation precedence index 0 checks for UDP packets (protocol number 17), in 
the port range 2455-5000. When these packets are identified, they are assigned a 64 kbps 
Streaming channel (the Streaming 64 profile).

2. The filter with evaluation precedence index 1 checks remaining packets for TCP packets 
(protocol number 6), on port 524. These packets are routed to the standard IP connection (the 
Standard profile).

3. Remaining traffic is routed to the standard IP connection.

Note Source and Destination are relative to the BGAN core network. This means that 
Destination is your terminal.
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Setting up user permissions

You can restrict access to parts of the web interface for non-administrator users. 

To set up the user permissions, do as follows:

1. From the left navigation pane, select ADMINISTRATION > User permissions.

2. For each item under ALLOW USERS TO:, select

• yes to allow access or 

• no to block access to the settings.

“Change general settings” means change the settings on the SETTINGS main page, that is 
enabling/disabling the L-Band interface.
“Control connections from IP handsets” means to start/stop data sessions using the main IP 
handset (handset with the number 0501).

3. At  ALLOW AT COMMANDS ON:, select

• yes to allow the use of AT commands on the LAN interface, or 

• no to block the use of AT commands on the LAN interface.

Note that this setting does not take effect until the terminal is restarted.

4. Click Apply.
The settings to which access is denied are now greyed out for the non-administrator user.
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Help desk and diagnostic report

Accessing the Help desk

If you need help with airtime-related issues you may call the Help desk. By default, the Help desk 
is the phone number for your Airtime Provider, if it is available on the SIM card.

To access the Help desk, select HELP DESK from the left navigation pane.

If the Help desk number is available on the SIM card, the number is displayed as a link. To change 
the number, click the link, change the number and click Apply.

If you need help with terminal- or antenna-related issues call your local distributor.

Generating a diagnostic report

The diagnostic report contains relevant information for troubleshooting. When contacting your 
distributor for support, please enclose this file.

To generate a diagnostic report, do as follows:

1. Click Generate report from the HELP DESK page. 
In some browsers the file may open directly in your browser. If it does, choose File > Save As 
to save the file.

2. Choose a location for the file and save it.
98-126882-C Help desk and diagnostic report 113



Chapter 4: Using the web interface
Event logging and self test

Viewing the Event list or the Event log

Overview

When an event is registered, the web interface shows an event icon in the icon bar as long 
as the event is active.

The Event list only shows events that are currently active, whereas the Event log shows the history 
of events that have occurred.

Event list

To view the event list, click the event icon from the icon bar at the top of the web interface, or 
select HELPDESK > Event list from the left navigation pane.

The Event list page shows a detailed list of active events including the time of the first occurrence, 
ID and severity of the event message, and a short text describing the error. For more information 
on the event messages, refer to Event messages on page 126.

Event log

The Event log shows the same information as the Event list, but also includes events that occurred 
in the past and are no longer active. Additionally, it lists events of informational character, 
describing normal phases of operation for the terminal.

To view the Event log, select HELPDESK > Event log from the left navigation pane.
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Self test

The Self test performs system test on the EXPLORER 727 system, similar to the tests that are 
performed during the Power On Self Test (POST).

To activate a Self test, do as follows:

1. Select HELPDESK > Self test.

2. Click Self test.

3. Click OK in the Warning dialog.
The terminal now reboots and performs a self test.

Site map

The web interface also offers a site map page. Use this page to get an overview of the submenus.

To access the site map, select SITE MAP from the left navigation pane.

Click on items in the site map to go directly to the relevant location.

Important The terminal must reboot to perform the self test. All ongoing calls or data sessions 
will be terminated.
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Troubleshooting 5

In this chapter

This chapter gives guidelines for troubleshooting and provides an overview of the different means 
of status signaling, It also lists available spare parts and accessories.

Getting support

Overview

If this manual does not provide the remedies to solve your problem, you may want to contact your 
Airtime Provider or your local distributor.

Airtime support

If you need assistance from your Airtime Provider, please call the help desk. 
To see the help desk number, enter the web interface of your terminal and select HELP DESK. This 
help desk number is either taken from the SIM card or entered manually. If no number is available 
under HELP DESK, check your Airtime subscription for a contact number.

System support

If you need assistance with problems caused by the terminal or antenna, please call a distributor 
in your area. 

A list of certified partners and distributors is available on Thrane & Thrane’s web site: 
www.thrane.com. Select Land Mobile and select Distributors from the top menu bar.
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Uploading software

Viewing software version status

To view the version of the embedded software in the terminal, do as follows:

1. Connect a computer.

2. Enter the web interface and see the Software version field in the Dashboard.

Uploading software using the web interface

You can upload software from the web interface. 

If you have an administrator user name and password you do not need to insert a SIM card nor to 
enter the PIN to be able to upload software.

For further information, see Uploading software on page 95.
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Part numbers

System units

TT-3722A EXPLORER®727 system

TT-3670A Thrane IP Handset & Cradle, wired

Item Part number

EXPLORER 727 antenna 403053B

EXPLORER terminal or

EXPLORER 19" Rack Terminal

403736A or 

403736A-T19

Item Part number

Thrane IP Handset, wired 403672A

Thrane IP Cradle, wired 403674A
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Troubleshooting guide

The below table provides information on some of the problems that might occur, including 
possible causes and remedies to solve the problems.

Problem Possible Cause Remedy

The terminal reboots 
spontaneously.

The input current is 
insufficient.

Make sure the power supply complies with 
the specifications for the terminal 
(10.5 - 32 V DC; 14 A - 5.5 A)

The terminal may reboot 
once at start-up if you 
are using the ignition 
system of your vehicle to 
power up the terminal.

None. Wait until the terminal is ready 
again after booting.

No signal or weak 
signal from the 
BGAN satellite.

The view to the satellite 
is blocked.

Make sure the antenna has a clear view in 
all directions. See the installation manual 
for details.

The antenna cable is not 
properly connected.

Check that both ends of the cable are 
connected properly according to the 
guidelines in the Installation manual.

Also check that no connectors are 
damaged.

The system is set up to 
use one specific satellite, 
but the system is outside 
coverage from that 
satellite.

Enter the web interface. Select SETTINGS > 
Satellite selection. Select Auto and click 
Apply. 

The system will now search for the satellite 
with the strongest signal and attempt to 
register.

No transmission on 
the BGAN network is 
possible.

The Radio silence 
function is activated 
from an external device 
connected to the I/O 
interface of the terminal.

If the Radio silence function should not be 
activated, deactivate it from the external 
device.

Connection to the 
Internet cannot be 
established.

Your network user group 
does not allow Internet 
access.

The administrator can access and change 
network user groups in the built-in web 
interface of the terminal.
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256 kbps Streaming 
does not work

1. The elevation angle 
to the satellite is too 
low.

2. There is not enough 
free bandwidth for a 
256 kbps streaming 
connection.

1. 256 kbps Streaming may not be 
available in areas with low elevation.

2. If there is too much traffic on the 
network, it may not be possible to 
assign a 256 kbps streaming session.

You may try a Streaming profile with a 
lower bit rate instead.

Some BGAN services 
are not available.

There may be limitations 
in the BGAN services, 
e.g. in low elevation or if 
the network is loaded 
with heavy traffic.

If possible, use another service.

To get information on limitations in 
services, you may contact Inmarsat 
support, e.g. from the web site 
www.inmarsat.com.

The web interface 
cannot be accessed.

The browser is 
configured to use a 
proxy server.

For Microsoft Internet Explorer, select Tools 
> Internet Options > Connections > LAN 
Settings and select Use a proxy server for 
your LAN.

You have entered a 
wrong IP address.

Check the IP address and re-enter it. If you 
do not have the correct IP address, you can 
set the IP address temporarily to the 
default address (192.168.0.1) by pressing 
the Reset button. See Function of the Reset 
button on page 134.

You are connected using 
VPN

Close down your VPN connection.

A Phone/Fax 
connection cannot 
be established.

The cable is not properly 
connected.

Connect the cable.

The cable type or 
connector type is not 
correct.

For information on the correct type of 
connector and cable, refer to the 
installation manual.

Incoming calls: The call 
type used for the call is 
not selected in the web 
interface.

Make sure the call type used for calls to the 
terminal is selected in the web interface. 
Access the web interface and select 
SETTINGS > Phone/Fax. Then, for each of 
the two ports, select the call type for 
incoming calls.

Problem Possible Cause Remedy
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An ISDN connection 
cannot be 
established

The cable is not properly 
connected.

Connect the cable.

You have connected to 
the LAN interface.

Connect the cable to the interface marked 
ISDN.

The cable type or 
connector type is not 
correct.

For information on the correct type of 
connector and cable, refer to the 
installation manual.

Incoming phone calls: 
The call type used for the 
call is not selected in the 
web interface.

Make sure the call type used for calls to the 
terminal is selected in the web interface. 
Access the web interface and select 
SETTINGS > ISDN. Then select the call type 
for incoming calls.

No phones are 
ringing on incoming 
calls

The Mute function is 
activated from an 
external device 
connected to the I/O 
interface of the terminal.

If the Mute function should not be 
activated, deactivate it from the external 
device.

A LAN connection 
cannot be 
established.

The cable is not properly 
connected.

Connect the cable.

The cable type or 
connector type is not 
correct.

For information on the correct type of 
connector and cable, refer to the 
installation manual.

Problem Possible Cause Remedy
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An IP handset 
connection cannot 
be established.

The cable is not properly 
connected.

Connect the cable.

You have connected to 
the ISDN interface.

Remove the cable and connect to one of 
the LAN connectors in stead.

There is no power (PoE) 
in the LAN interface. The 
reason may be that there 
is not enough power to 
supply PoE for the LAN 
interface.

Check that the input voltage is within the 
specified range 
(10.5 - 32 V DC; 14 A - 5.5 A).

Check that you do not have too many 
power-consuming devices connected. The 
maximum available output power on the 
LAN (PoE) interface is 32 W if you are using 
a 12 V supply and 64 W if you are using a 
24 V supply. 
If possible, disconnect other connected 
devices.

Incoming phone calls: 
The call type used for the 
call is not selected in the 
web interface.

Make sure the call type used for calls to the 
terminal is selected in the web interface. 
Access the web interface and select 
SETTINGS > IP handset > Call settings. Then 
select the call type for incoming calls.

The administrator 
password does not 
work.

Someone has changed 
the administrator 
password.

If the correct password is not found, you 
have to reset the password. 

Contact your supplier for a reset code. You 
must provide the serial number and IMEI 
number of the terminal.

Then enter the web interface and reset the 
password as described in: Resetting the 
administrator password on page 101.

Problem Possible Cause Remedy
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Status signaling

Overview

There are many ways of troubleshooting if an error occurs. The terminal has different means of 
status signaling, to help you find the cause of a problem:

• Indicators.

• Event messages.

• Event log.

Indicators, event messages and logs are described in the following sections.

Light indicators

Overview

The terminal has a number of LEDs, placed in the panel at the top of the terminal:

• a green Power indicator,

• a green/red/orange Terminal indicator,

• a green/red/orange Antenna indicator,

• a green Message indicator and

• 3 LAN indicators for each LAN interface, showing Activity (Green), Link/Speed (Green/Yellow) 
and PoE (Green/Red).

General status indicator functions
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Power indicator

Terminal indicator

Antenna indicator

Behavior Meaning

Green Power OK.

Flashing green The terminal is powering up.

Flashing orange The terminal is closing down.

Off No power.

Behavior Meaning

Steady green Ready. BGAN registration completed.

Flashing green Please wait - process in progress. 
BGAN registration ongoing.

Orange Warning - temporary malfunction. User action 
is required.

Red Critical error. 

Check the event log. If the problem is in the 
EXPLORER system and you cannot solve it, 
contact your distributor and return the unit for 
repair if necessary.

Behavior Meaning

Steady green Tracking. The antenna is ready for use.

Flashing green Please wait - process in progress. 

Slow flashing: The antenna is starting up

Rapid flashing: Sky scan

Orange Warning - temporary malfunction. User action 
is required.

Red Critical error. 

Check the event log. If the problem is in the 
EXPLORER system and you cannot solve it, 
contact your distributor and return the unit 
for repair if necessary.
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Message indicator

LAN indicator functions

Activity indicator

Link/Speed indicator

PoE indicator

Behavior Meaning

Flashing green A new SMS message has arrived.

Off No new messages, or the unit is off.

Behavior Meaning

Flashing green The LAN port is active.

Behavior Meaning

Green Link speed is 100 Mbps.

Yellow Link speed is 10 Mbps.

Off The link is down.

Behavior Meaning

Green The terminal is supplying power to the LAN 
port.

Red The connected device requires more power 
than the terminal can supply to the LAN port.

Off The terminal is not supplying power to the 
port.
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Event messages

Display of event messages

The terminal can detect events during POST (Power On Self Test) or CM (Continuous Monitoring). 
When the terminal detects an event that requires your action, it issues an event message.

When your terminal issues an event message, the Terminal 
indicator or the Antenna indicator in the LED panel on top of 
the terminal signals the event, according to the tables 
Terminal indicator and Antenna indicator in the previous 
section.

You can see the active event messages in the web interface by clicking the warning symbol in the 
icon bar at the top in the web interface.

All events are logged in the event log. For information on the event log, see Viewing the Event list 
or the Event log on page 114.
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List of events

The following list explains the events that may show in the web interface of the terminal.

ID Event Text Explanation Remedy

00100 to 
00199

System data 
damaged

Important system data is 
damaged

Do not use the terminal. 
Contact your distributor.

00210 to 
00219

SIM module 
error

The SIM interface on the 
terminal cannot be used.

Contact your distributor.

00240 to 
00249

Temperature 
sensor error

The terminal is in danger of 
overheating.

Do not use the terminal. 
Contact your distributor.

00260 to 
00269

System error The terminal cannot 
communicate on the 
satellite network.

Contact your distributor.

00270 to 
00279

Voice module 
error

Voice services cannot be 
accessed by the terminal

Contact your distributor.

00280 to 
00289

Ethernet 
module error

The Ethernet interface on 
the terminal cannot be 
used.

Contact your distributor.

00300 to 
00309

GPS module 
error

The GPS module is out of 
function. The terminal 
cannot obtain a valid GPS 
position.

Contact your distributor.

00330 to 
00339

ISDN failure The ISDN interface on the 
EXPLORER 727 cannot be 
used.

Contact your distributor.

00340 to 
00349

2-wire failure The Phone/Fax interface of 
the EXPLORER 727 cannot 
be used.

Contact your distributor.

00350 to 
00359

AD9864 
calibration 
data error

Internal error in the 
receiving part of the 
terminal.

Contact your distributor if 
the problem persists.

00360 to 
00369

No antenna 
found

The terminal cannot 
communicate with the 
antenna.

1. Check antenna cable 
between terminal and 
antenna.

2. Reboot the terminal.
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01000 to 
01009

Low 
temperature 
warning

Low ambient temperature 
is causing the performance 
of the terminal to be 
degraded or halted.

Move the terminal to a 
warmer location.

For information on ambient 
temperature limits, see the 
installation manual.

01010 to 
01019

Temperature 
too low 
(critical)

Low ambient temperature 
is causing the performance 
of the terminal to be 
degraded or halted.

Move the terminal to a 
warmer location.

For information on ambient 
temperature limits, see the 
installation manual.

01100 to 
01109

High 
temperature 
warning

High ambient temperature 
is causing the performance 
of the terminal to be 
degraded or halted.

Move the terminal to a 
cooler location.

For information on ambient 
temperature limits, see the 
installation manual.

01110 to 
01119

Temperature 
too high 
(critical)

Critically high temperature 
is causing the terminal to 
shut down.

Move the terminal to a 
cooler location.

For information on ambient 
temperature limits, see the 
installation manual.

Contact your distributor if 
the problem persists.

01300 to 
01309

No GPS fix The GPS receiver has not 
yet achieved position fix.

Make sure the view to the 
GPS satellites is not 
blocked. 

Note that in some cases it 
may take up to 10 minutes 
to obtain GPS fix.

01400 to 
01409

Satellite 
signal lost

The EXPLORER 727 no 
longer receives a signal 
from the satellite.

Make sure the 
EXPLORER 727 has a clear 
view to the satellite.

01500 to 
01509

SIM card 
missing

No SIM card is detected in 
the SIM slot.

Insert SIM card. 

If the SIM card is already 
inserted, try removing and 
reinserting it.

ID Event Text Explanation Remedy
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01600 to 
01609

SOS calls only The SIM card is not 
accepted by the network. 
Only emergency calls are 
allowed.

Enter the PIN and wait for 
network approval. If the 
problem persists, contact 
your Airtime Provider.

01700 to 
01709

Registration 
for voice 
failed

The EXPLORER 727 has not 
yet been allowed to register 
for voice services (Circuit 
Switched).

If the problem persists, 
contact your Airtime 
Provider.

01800 to 
01809

Registration 
for data 
failed

The EXPLORER 727 has not 
yet been allowed to register 
for data services (Packet 
Switched).

If the problem persists, 
contact your Airtime 
Provider.

02000 to 
02009

Satellite 
signal weak

The signal from the 
satellite is weak.

Check the line of sight to 
the satellite. Be aware that 
window glass may reduce 
the signal level. 

Check that the antenna is 
pointed according to the 
position data. Adjust the 
position to the highest 
possible signal strength.

02100 to 
02109

Ciphering Off The network has turned 
ciphering off.

Do not transmit data that 
requires ciphering.

02200 to 
02209

Ethernet data 
session failed

Ethernet data session could 
not be established.

See the call log for the 
cause of the error. Refer to 
Viewing the lists of calls on 
page 55.

If the problem persists, 
contact your distributor.

02900 to 
02909

Network failed 
authentication

The EXPLORER 727 does 
not accept the network as a 
valid BGAN network.

Restart the EXPLORER 727.

 If the problem persists, 
contact your distributor.

ID Event Text Explanation Remedy
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03500 to 
03509

2-wire 
calibration 
failure

2-wire calibration failed on 
the Phone/Fax interface, 
because of:

1. Common mode 
balance error.

2. The hook is off.

3. Wires are shorted to 
each other or shorted 
to ground.

1. Check the wires to your 
phone or fax.

2. Put the hook on.

3. Check the wires.

03600 to 
03609

2-wire 
operational 
failure

The Phone/Fax interface 
fails to operate, for one of 
the following reasons:

1. Ground shorted.

2. Power overload.

3. Temperature overload.

1. Check the wires.

2. Wait until the event is 
cleared; then try again.

3. Wait until the event is 
cleared; then try again.

08002 One or more 
ports has PoE 
disabled due 
to power 
limitations

The power supply to the 
terminal has dropped 
critically. PoE is disabled to 
ensure enough power to 
the antenna.

Ensure a stable power 
supply to the terminal.

08008 Antenna 
exceeds 
voltage 
threshold

The antenna voltage is 
either too high or too low.

Check the cable to the 
antenna.

Contact your distributor if 
the problem persists.

08009 Power Hold-up 
- the terminal 
can no longer 
power the 
antenna

The power supply to the 
terminal has dropped for 
too long. The antenna does 
not have enough power to 
function.

Ensure a stable power 
supply to the terminal.

0800A Reduce PoE - 
the terminal 
reduces PoE 
with 30W

The input voltage to the 
terminal is too low. The 
terminal will lower PoE 
power from 60 W to 30 W.

Ensure a stable power 
supply to the terminal.

ID Event Text Explanation Remedy
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0800B PoE 
Overvoltage 
protection is 
activated

Overvoltage is detected in 
the terminal. The terminal 
will be shut down in 10 
minutes.

Do not use the terminal.

Contact your distributor.

0800D Antenna 
Overvoltage 
protection is 
activated

Overvoltage is detected in 
the antenna. The terminal 
will be shut down in 10 
minutes.

Do not use the terminal.

Contact your distributor.

08010 Undervoltage 
has been 
detected

The input voltage has 
dropped below an 
acceptable level. The 
terminal will be shut down 
in 10 seconds if the 
situation persists.

Ensure a stable power 
supply to the terminal.

0801B Lost 
connection to 
the GPS 
receiver

Communication with the 
GPS receiver in the 
antenna is lost.

Contact your distributor if 
the warning persists.

0801D Uploading 
firmware to 
antenna

New firmware is being 
uploaded to the antenna.

The Event will be cleared 
when upload has finished.

Contact your distributor if 
the Event is not cleared 
within 5 minutes.

0802C Firmware 
update still 
fails after 
several 
retries

The terminal was unable to 
upload new firmware to the 
antenna.

Contact your distributor.

0802D Firmware 
update failed

The terminal was unable to 
upload new firmware to the 
antenna.

Reboot the terminal.

Contact your distributor if 
the problem persists.

0802E Firmware is 
older than 
current 
antenna 
version

The firmware in the 
antenna is newer than 
expected by the terminal.

Update the terminal 
software.

0802F Antenna main 
image could 
not be loaded

Antenna failed to start up 
normally.

Reboot the terminal.

Contact your distributor if 
the problem persists.

ID Event Text Explanation Remedy
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08030 Antenna could 
not enter main 
application 
mode

Antenna failed to start up 
normally.

Reboot the terminal.

Contact your distributor if 
the problem persists.

08031 Failed to 
enter normal 
operation

Antenna failed to start up 
normally.

Reboot the terminal.

Contact your distributor if 
the problem persists.

08032 Firmware image 
version lower 
than active 
antenna 
version

The firmware in the 
antenna is newer than 
expected by the terminal.

Update the terminal 
software.

08033 Firmware image 
doesn't 
support 
antenna 
hardware

The antenna hardware 
version is not supported by 
the terminal.

Contact your distributor.

08034 Antenna failed 
to exit Flash 
Manager. Power 
cycle needed

New firmware was 
successfully uploaded to 
the antenna but the 
antenna failed to start 
normally with the new 
firmware.

Reboot the terminal. 
Contact your distributor if 
the problem persists.

08035 Unable to open 
port for HPA 
burst 
monitoring

There was an error 
communicating with the 
antenna.

Reboot the terminal. 
Contact your distributor if 
the problem persists.

08036 Radio silence 
is activated

The Radio silence function 
is activated. No 
transmission is allowed.

If the Radio silence 
function should not be 
active, enter the web 
interface and select 
SETTINGS > Discrete I/O. 
Then clear the Enabled box 
for Radio silence.

ID Event Text Explanation Remedy
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Logging of events

Diagnostic report

When contacting your distributor for support, please include a diagnostic report. 
The diagnostic report contains information relevant for the service personnel during 
troubleshooting. 

To generate the diagnostic report, access the web interface and select HELPDESK. Then click 
Generate report. 

Event log

The event log holds information of events registered in the terminal or antenna. The same events, 
when active, are also indicated in the Antenna and Terminal LEDs on the terminal LED panel.

The log includes the time of the occurrence, a short description, location of the error etc. This 
information can help troubleshooting errors in the system. You can see the event log in the web 
interface. For further information, see Viewing the Event list or the Event log on page 114.
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Reset button

How to access the Reset button

The terminal has a Reset button placed next to the SIM slot behind the SIM cover. The functions of 
this button is described in the next section.

To press the Reset button, use a pointed device.

Function of the Reset button

The Reset button on the terminal has the following functions:

Action Function

With the terminal running, 
press the Reset button 
normally.

The terminal IP address and IP netmask are temporarily set to 
the default value (default IP address: 192.168.0.1). 

With this function, even if the IP address has been changed 
and you do not remember the new IP address, you can still 
access the web interface and see your current configuration. 
The default value is not saved in the configuration, but is only 
valid until next reboot.

With the terminal running, 
press and hold the Reset 
button for 30 seconds, until 
the Power indicator on the 
terminal is flashing orange.

The terminal restores factory settings and reboots the system.

While the terminal is booting, 
press and hold the Reset 
button.

For service use only! 
The bootloader initiates software upload.

Refer to the installation manual for details.
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Conformity 6

EXPLORER®727

CE (R&TTE)

The EXPLORER 727 is CE certified (R&TTE directive) as stated in the “Declaration of Conformity with 
R&TTE Directive”, enclosed in copy on the next page.

FCC

This device complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions:

1) This device may not cause harmful interference, and 

2) this device must accept any interference received, including interference that may cause 
undesired operation.

Part 15.21
Changes or modifications not expressly approved by the party responsible for compliance could 
void the user's authority to operate the equipment.

 

Note The manufacturer is not responsible for any radio or TV interference caused by 
unauthorized modifications to this equipment. Such modifications could void the user's 
authority to operate the equipment.
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EXPLORER®727 19" Rack

CE (R&TTE)

The EXPLORER 727 19" Rack is CE certified (R&TTE directive) as stated in the “Declaration of 
Conformity with R&TTE Directive”, enclosed in copy on the next page.

FCC

This device complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions:

1) This device may not cause harmful interference, and 

2) this device must accept any interference received, including interference that may cause 
undesired operation.

Part 15.21
Changes or modifications not expressly approved by the party responsible for compliance could 
void the user's authority to operate the equipment.

 

Note The manufacturer is not responsible for any radio or TV interference caused by 
unauthorized modifications to this equipment. Such modifications could void the user's 
authority to operate the equipment.
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Glossary
Glossary
A

APN Access Point Name. The Access Point Name is used by the terminal operator to establish the 
connection to the required destination network. 

B

BGAN Broadband Global Area Network. A satellite network based on geostationary satellites, 
delivering data rates of up to 492 kbps to virtually any part of the earth, with full UMTS (3G) 
compatibility. 

C

CE Conformitée Européenne. This term signifies that a CE certified product conforms to European 
health, environmental, and safety regulations. In short, it makes the product legal to be sold 
in the European Union. 

CID Context Identifier 

CM Continuous Monitoring 

CS Circuit-Switched. Circuit-switched networks require dedicated point-to-point connections 
during calls. 

D

DHCP Dynamic Host Configuration Protocol. A protocol for assigning dynamic IP addresses to 
devices on a network. With dynamic addressing, a device can have a different IP address 
every time it connects to the network. 

DNS Domain Name System. A system translating server names (URLs) to server addresses. 

F

FCC Federal Communications Commission. An independent United States government agency, 
directly responsible to Congress. FCC certification is normally required to make a product 
legal to be sold in the United States. 
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G

Geostationary Placed in a fixed position relative to a point on the surface of the earth. 

GPS Global Positioning System 

I

I/O Input/Output 

IMEI International Mobile Equipment Identity. A unique number identifying your terminal 

IMSO International Maritime Satellite Organisation. An intergovernmental body established to 
ensure that Inmarsat continues to meet its public service obligations, including obligations 
relating to the GMDSS. 

IP Internet Protocol 

ISDN Integrated Services Digital Network. A circuit-switched telephone network system, designed 
to allow digital transmission of voice and data over ordinary telephone copper wires, 
resulting in higher quality and speed than are available with analog. 

K

kbps kilobits per second 

L

LAN Local Area Network 

LED Light Emitting Diode 

M

MAC Media Access Control. 

MSN Multiple Subscriber Numbering. In most pieces of ISDN equipment you can program multiple 
subscriber numbers. The number programmed into the equipment should be the dial-in 
number that you wish that piece of equipment to answer. 
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N

NAT Network Address Translation. An Internet standard that enables a local-area network to use 
one set of IP addresses for internal traffic and a second set of addresses for external traffic. 
A NAT module makes all necessary address translations. 

P

PDP Packet Data Protocol. A network protocol used by external packet data networks that 
communicate with a GPRS network. 

PIN Personal Identification Number. A code number used to provide access to a system that has 
restricted access. 

PoE Power over Ethernet 

POST Power On Self Test. A test sequence that runs every time the system is powered up or reset. 

PS Packet-Switched. Packet-switched networks move data in separate, small blocks (packets) 
based on the destination address in each packet. 

PUK PIN Unblocking Key. An eight-digit code used to unblock a SIM card after three incorrect PINs 
have been entered. The PUK code is supplied with the SIM card. 

Q

QoS Quality of Service 

R

RDI Restricted Digital Information 

RF Radio Frequency. Electromagnetic wave frequencies between about 3 kilohertz and about 
300 gigahertz including the frequencies used for communications signals (radio, television, 
cell-phone and satellite transmissions) or radar signals. 

S

SAS Satellite Access Station. The gateway between the satellites and the worldwide networks such 
as Internet, telephone network, cellular network etc. 

SDU Service Data Unit. Also known as a data packet. 
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SIM Subscriber Identity Module.The SIM provides secure storing of the key identifying a mobile 
phone service subscriber but also subscription information, preferences and storage of text 
messages. 

SMS Short Messaging Service 

Streaming A technique for transferring data - such as audio or video clips - so that it is processed as a 
continuous stream. With a Streaming connection you are charged by the minute, like for a 
telephone connection. 

T

TCP Transmission Control Protocol. One of the core protocols of the Internet protocol suite. TCP 
provides reliable, in-order delivery of a stream of bytes, making it suitable for applications 
like file transfer and e-mail. 

U

UDI Unrestricted Digital Information 

UDP User Datagram Protocol. One of the core protocols of the Internet protocol suite. UDP delivers 
data fast, because it avoids checking data packets. Time-sensitive applications often use UDP 
because dropped packets are preferable to delayed packets. 

UTC Coordinated Universal Time. The International Atomic Time (TAI) with leap seconds added at 
irregular intervals to compensate for the Earth’s slowing rotation. Leap seconds are used to 
allow UTC to closely track UT1, which is mean solar time at the Royal Observatory, Greenwich. 

V

VPN Virtual Private Network. A network that is constructed by using public wires to connect nodes. 
You can create networks using the Internet for transporting data, using security mechanisms 
so that only authorized users can access the network. 
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Index
Numerics
2-wire interface

local numbers, 32
setting call type, 66

A
administration settings, 100
analog phone

local numbers, 32
antenna

viewing properties, 62
viewing status, 49
viewing type, 49

APN, common setting, 69
audio quality, 28

B
barring calls, 73
BGAN

connecting to, 23
coverage, 8
services, 10
system overview, 9

Bridge mode, 85
browser settings

for web interface, 43

C
call log, 54
call type, 28

setting for IP handsets, 79
setting for ISDN, 67
setting for Phone/Fax interface, 66
98-126882-C
calls
barring, 73
closed user group, 76
forwarding, 72
holding, 34
line identification, 75
local, 31
making or receiving, 29
missed, received, outgoing, 55
redial, 32
to the terminal, 31
transferring, 34
viewing ongoing, 49
waiting indication, 33, 74

CE compliance, 135
clearing logs, 105
clearing usage counter, 105
closed user group, 76
common network settings, 69
compression, header, 93
computer, connecting to LAN, 20
configuration

exporting to file, 103
importing from file, 103
ISDN, 67
LAN, 63

conformity, 135
connecting to the BGAN network, 23
connector panel, 13
contact information, 116
coverage

Inmarsat BGAN system, 8

D
dashboard, 48
data

profiles, 106
traffic flow filters, 109

data sessions
viewing ongoing, 49

Declarations of Conformity, 136, 138
default

IP address, 44
network setup, 38

dialing prefixes, 33
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Index
document number
installation manual, v
IP handset user manual, v

E
Ethernet interface

setting up, 63
events

in LED panel, 126
list of active, 114

exporting configuration, 103

F
fax, sending or receiving, 35
FCC compliance, 135, 137
features overview, 2
forwarding calls, 72

H
Header compression, 93
help desk number, 113

changing in web interface, 113
holding a call, 34

I
ignition function, 16
IMEI number, 49
importing configuration, 103
Inbox for SMS messages

replying, forwarding or deleting, 59
indicator functions, 123
installation manual

document number, v
interfaces and services

combinations, 12
internal calls, 31
Internet connection, 20
IP address

external, setting up, 86
for connected device, 88
for web interface, 44
local, setting up, 64
local, viewing, 49
98-126882-C
IP handset
BGAN features, 25
connecting, 18
description, 6
entering PIN, 21
local numbers, 32
power supply, 18
setting call type, 79
setting up, 77
starting up, 18
user manual, v

ISDN interface
local numbers, 32
setting up, 67

L
LAN

connecting a computer, 20
managing network users, 82
setting up interface, 63

L-Band interface
enabling or disabling, 62

LED functions, 123
light indicator functions, 123
limitations in services, 11
line identification, 75
local numbers assigned, 32
local phone call, 31
logs, clearing, 105

M
MAC address, 49
matrix of services and interfaces, 12
messages

configuring outgoing, 60
forwarding, 59
opening in web interface, 59
receiving in web interface, 58
replying, 59
sending, 58

microwave radiation, iii
mobile numbers

viewing and editing, 53

N
navigation in web interface, 46
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Index
network classification table, 90
network devices, 88
network management, 82
network setup, default, 38
network terms

definitions, 93
network user groups, 82

O
Outbox for SMS messages

resending or deleting messages, 57

P
phone

local call, 31
making calls, 29

phone book, 51
adding number, 52
deleting all entries, 52
deleting an entry, 52
modifying an entry, 52

phone numbers for terminal, 53
Phone/Fax interface

local numbers, 32
setting call type, 66

PIN
administration PIN, 100
entering, 21
entering in web interface, 47
entering with a phone, 21
entering with IP handset, 21

PoE, 18
port forwarding, 65
Power over Ethernet, 18
power supply for IP handset, 18
powering the terminal, 15
prefixes, special-purpose, 33
profiles for data transmission, 106
properties

antenna, 62
system, 49

Proxy server, disabling, 43
PUK code, 21, 22, 47

Q
quality of voice, 28
98-126882-C
Quick dial, 30

R
radiation, iii
redial, 32
registering on the BGAN network, 23
remote on/off, 17
Router mode, 85

S
safety summary, iii
satellite

selecting, 98
view selected, 49

sent messages
resending, forwarding or deleting, 57
viewing status, 57

serial number, 49
services

limitations, 11
supplementary, 67
supported by BGAN, 10

services and interfaces
combinations, 12

Short dial, 30
show number, 75
SIM lock, 11
site map of web interface, 115
SMS in web interface

forwarding, 59
opening, 59
receiving, 58
replying to, 59
sending, 58

SMS service number, 61
software

uploading, 95
viewing version, 49

Standard IP, 37
activating, 38, 39
definition, 37

status
methods for signaling, 123
ongoing calls and data sessions, 49
viewing, 48

Streaming IP, 37
activating, 40
definition, 37
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Index
supplementary services
setting up, 67
supported, 11
using, 33

support
contact information, 116

T
telephone interface

local numbers, 32
setting call type, 66

tools for setting up the terminal, 25
total usage

viewing, 49, 54
traffic flow filters, 109
transferring a call, 34
troubleshooting guide, 119
typography used in this manual, v

U
uploading software, 95
usage counter, 49, 54

clearing, 105
user interfaces, 25

V
version of software, 49
voice mail number

viewing, 61
voice quality, 28

setting for IP handsets, 79
setting for ISDN, 67
setting for Phone/Fax interface, 66

W
waiting calls, 33, 74
web interface

accessing, 42
browser settings, 43
definition, 42
navigating, 46
site map, 115
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